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2. Enter the text to find in the text box.

3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in the box.  For example, if you search for the word stick, the words tick and sticky will not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in the box.

Find Backwards starts the search from the current page and goes backwards through the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.

To find the next occurrence of the word, Do one of the following:
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            Reopen the find dialog box, and click Find Again. 

            (The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into another application such as a word processor.  You can also paste text into a PDF document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved.  A default font  is substituted.

To select and copy it to the clipboard:
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       To select a line of text, select the first letter of the sentence or phrase and drag to

       the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option (Mac OS) as you drag across the width of the document. 

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text on the current page is selected.  In Continuous or Continuous – facing mode, most of the text in the document is selected.  When you release the mouse button, the selected text is highlighted.  To deselect the text and start over, click anywhere outside the selected text.  

The Select All command will not select all the text in the document.  A workaround for this (Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.

[There is no reportable action as a result of either of

the Board of Supervisors' closed sessions held today.]
SUP. YAROSLAVSKY, CHAIRMAN: GOOD AFTERNOON. THE MEETING OF THE BOARD OF SUPERVISORS IS NOW IN SESSION. I'D LIKE TO ASK EVERYONE TO STAND FOR THE INVOCATION AND THE PLEDGE OF ALLEGIANCE. THE INVOCATION WILL BE LED BY PASTOR RON FERNANDEZ OF THE WHITTIER APOSTOLIC FAITH CENTER AND THE PLEDGE OF ALLEGIANCE WILL BE LED BY JOSEPH SAPIEN, MEMBER OF POST NUMBER 8 OF THE LOS ANGELES AMERICAN LEGION. PASTOR FERNANDEZ? 

PASTOR RON FERNANDEZ: THANK YOU. GOOD MORNING EVERYONE. THANK YOU SUP. KNABE FOR THE INVITATION TO GIVE THE INVOCATION TODAY TO THE BOARD OF SUPERVISORS AND ALL THOSE THAT ARE IN THIS MEETING TODAY. I GIVE MY REPECT, TRIBUTE TO ALL THE LOS ANGELES COUNTY SUPERVISORS FOR THE SERVICE THAT YOU HAVE GIVEN TO OUR COMMUNITIES AND GIVE TO THEM. I'M GOING TO ASK EVERYONE TO BOW YOUR HEADS FOR A MOMENT AND I'M GOING TO LEAD YOU IN A PRAYER. LET'S ALL BOW OUR HEADS FOR A MOMENT.  GOD OF HEAVEN, CREATOR OF HEAVEN AND EARTH. YOU ARE OMNIPOTENT, YOU ARE OMNISCIENT, YOU ARE OMNI-PRESENT. YOU ARE ETERNAL. YOU ARE ALMIGHTY, ALL- WISE, ALL-KNOWING, EVERYWHERE AT THE SAME TIME. WE RECOGNIZE AND HONOR YOUR PRESENCE IN OUR MIDST TODAY. YOU'RE GOOD. YOU'RE KIND. YOU'RE MERCIFUL. YOU'RE COMPASSIONATE AND YOU'RE CARING. WE THANK YOU BECAUSE YOU LOVE AND DESIRE THE BEST FOR ALL OF YOUR CHILDREN: RED, YELLOW, BLACK AND WHITE, THEY ARE ALL PRECIOUS IN YOUR SIGHT. WE ALSO THANK YOU TODAY FOR YOUR MANY BLESSINGS, FOR FREEDOM AND LIFE AND PEACE IN THE MIDST OF A DIFFICULT, COMPLEX AND DISTURBING TIME WHERE THERE ARE SO MANY NEEDS. MANY ARE CONCERNED, WORRIED, ANXIOUS AND FEARFUL ABOUT THE PRESENT, THE FUTURE OF OUR CITIES, COUNTIES, STATE, COUNTRY AND WORLD. WE PRAY FOR ALL THOSE WHO ARE IN AUTHORITY WORKING IN OUR CITIES IN THE LOS ANGELES COUNTY, ALL GOVERNMENT WORKERS, MAYORS, ADMINISTRATORS, LEADERS AND THE SUPERVISORS WHO ARE INVOLVED IN SERVING TO HELP MEN AND WOMEN, YOUNG AND OLD, TO BE THEIR BEST AND TO REACH THEIR HIGHEST AND MAXIMUM POTENTIAL. WE PRAY THAT YOU WOULD BLESS THEM AS A TEAM. KEEP THEM FILLED WITH YOUR LOVE, PEACE, FAITH, WISDOM, STRENGTH AND THE COURAGE TO DO THE THINGS THAT WILL BRING HEALTH, FRUITFULNESS, PRODUCTIVITY AND PROSPERITY TO ALL. BLESS THEM WITH VISION, CREATIVITY AND ENTHUSIASM. HELP THEM TO KEEP A GOOD POSITIVE ATTITUDE, PASSION AND UNITY SO THAT THEY CAN BE AND DO THE BEST FOR THE PEOPLE THAT THEY SERVE. LORD, WE ALSO PRAY TODAY FOR ALL THE RESOURCES, FOR THE MENTAL, PHYSICAL, EDUCATIONAL, SOCIAL, FINANCIAL AND FAMILY NEEDS. CONTINUE TO GIVE GOOD AND WISE COUNSEL AND STRONG AND HEALTHY LEADERSHIP TO HELP INFLUENCE FOR THE BETTERMENT OF OUR GREAT COUNTRY THE UNITED STATES OF AMERICA. WE LOOK TO YOU TODAY BECAUSE YOU ARE ABLE TO DO EXCEEDINGLY, ABUNDANTLY AND ABOVE ALL THAT WE CAN ASK OR THINK AND ALSO SHOW US GREAT AND MIGHTY THINGS THAT WE DO NOT KNOW. WE PRAY THIS TODAY IN THE NAME OF THE LORD GOD ALMIGHTY. GOD BLESS YOU. 

JOSEPH SAPIEN: [PLEDGE OF ALLEGIANCE RECITED.] 

SUP. YAROSLAVSKY, CHAIRMAN: SUPERVISOR KNABE? 

SUP. KNABE: TODAY, AS WAS MENTIONED, WE HAVE PASTOR RON FERNANDEZ OF THE APOSTOLIC FAITH CENTER IN UNINCORPORATED WHITTIER. A GREAT MISSIONARY IN THAT PARTICULAR AREA AND HIS OUTREACH TO THE COMMUNITY AND HOW HE SERVES THE PEOPLE IN ADDITION TO SPREADING THE WORD OF THE LORD, HIS GIVEBACK TO THAT COMMUNITY IS GREATLY APPRECIATED BY US ALL. HE AND I ALSO HAVE A UNIQUE BOND AS I'VE TOLD THE STORY IN THE PAST THAT MY GRANDFATHER WAS AN APOSTOLIC PREACHER, AS WELL. PASTOR FERNANDEZ HAS BEEN A MINISTER FOR 34 YEARS WITH THE APOSTOLIC ASSEMBLY AND PRESENTLY APOSTOLIC FAITH CENTER IN WHITTIER FOR 15 YEARS. HE HAS BEEN A MISSIONARY IN THE COUNTRY OF CHILE AND HAS BEEN IN COUNTRIES IN ALL FOUR CONTINENTS. HE IS THE AUTHOR OF A BOOK ENTITLED THE PAINS OF GROWING AND PRESENTLY WORKING HIS SECOND BOOK RENEWING YOUR FAITH THROUGH THE 23RD PSALM. HE IS WORKING ON HIS DOCTORATE FROM LOGOS UNIVERSITY IN FLORIDA. HE HAS BEEN MARRIED TO HIS BEAUTIFUL WIFE FRANCES, THEY HAVE TWO DAUGHTERS AND THREE GRANDCHILDREN. SO ON BEHALF OF MY COLLEAGUES AND THE CITIZENS OF THIS GREAT COUNTY, WE THANK YOU FOR TAKING THE TIME OUT OF YOUR VERY BUSY SCHEDULE TO LEAD US IN THE INVOCATION. GOD BLESS. [APPLAUSE.] 

SUP. YAROSLAVSKY, CHAIRMAN: WE WERE LED IN THE PLEDGE OF ALLEGIANCE THIS AFTERNOON BY JOSEPH SAPIEN WHO IS A RESIDENT OF NORTHRIDGE AND IS REPRESENTING THE AMERICAN LEGION POST NUMBER 8. JOSEPH SERVED IN THE UNITED STATES ARMY FROM 2001-2003 OBTAINING THE RANK OF CORPORAL. HE SERVED IN IRAQ. HE'S RECEIVED THE ARMY GOOD CONDUCT MEDAL, THE NATIONAL DEFENSE SERVICE MEDAL, THE ARMED FORCES EXPEDITIONARY MEDAL, THE IRAQ CAMPAIGN MEDAL, GLOBAL WAR EXPEDITIONARY MEDAL AND GLOBAL WAR-- WE ALREADY SAID THAT. HE IS A VETERAN COUNSELOR WITH THE LOS ANGELES COUNTY MILITARY AND VETERANS AFFAIRS DEPARTMENT. HE'S A THREE-YEAR RESIDENT OF OUR DISTRICT, ATTENDED CERRITOS HIGH SCHOOL IN CERRITOS, CALIFORNIA AND CAL STATE NORTHRIDGE. JOSEPH, THANK YOU VERY MUCH FOR LEADING US IN THE PLEDGE AND FOR YOUR SERVICE TO OUR COUNTRY. [APPLAUSE.] ALL RIGHT. THE BOARD SECRETARY CALL THE AGENDA. 

CLERK SACHI HAMAI: GOOD AFTERNOON, MR. CHAIRMAN, MEMBERS OF THE BOARD. WE WILL BEGIN TODAY'S AGENDA ON PAGE THREE, AGENDA FOR THE MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION, ITEM NUMBER 1-D IS BEFORE YOU. 

SUP. YAROSLAVSKY, CHAIRMAN: MOVED BY KNABE. SECONDED BY RIDLEY-THOMAS. WITHOUT OBJECTION, UNANIMOUS VOTE. 

CLERK SACHI HAMAI: ON PAGE FOUR, AGENDA FOR THE MEETING OF THE REGIONAL PARK AND OPEN SPACE DISTRICT, ITEMS 1-P THROUGH 4-P. ON ITEM NUMBER 3-P, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. THE REMAINING ITEMS ARE BEFORE YOU. 

SUP. YAROSLAVSKY, CHAIRMAN: IT'S MOVED BY MOLINA, SECONDED BY ANTONOVICH; WITHOUT OBJECTION, UNANIMOUS VOTE. 

CLERK SACHI HAMAI: ON PAGE SIX, BOARD OF SUPERVISORS ITEMS 1 THROUGH 16. ON ITEM NUMBER 2, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. 

SUP. KNABE: WHAT ITEM? 

CLERK SACHI HAMAI: 2. ON ITEM NUMBER 3, THERE'S A REQUEST IF MEMBERS OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NUMBER 5, SUPERVISOR KNABE REQUESTS THAT THIS ITEM BE REFERRED BACK TO HIS OFFICE. ON ITEM NUMBER 6, SUPERVISOR ANTONOVICH WOULD LIKE TO AMEND HIS -- OR REVISE HIS MOTION AND THEN CONTINUE IT FOR TWO WEEKS. SO HE WOULD LIKE TO JUST REVISE THE LAST PORTION OF IT TO SAY, "AND A SUBSTANTIAL NUMBER OF THE VOTERS WHO VOTE IN THE ADVISORY ELECTION SUPPORT THE AMENDMENT" VERSUS "AND IF THE MAJORITY OF THE VOTERS." SO WITH THAT, I'M SORRY, NOT SUPERVISOR ANTONOVICH, BUT SUPERVISOR YAROSLAVSKY REQUESTS. 

SUP. YAROSLAVSKY, CHAIRMAN: WITHOUT OBJECTION, THE AMENDMENT, SUPERVISOR ANTONOVICH'S AMENDMENT TO HIS OWN MOTION WOULD BE ACCEPTED. AND THEN WE'LL PUT THIS OVER FOR TWO WEEKS. 

CLERK SACHI HAMAI: TWO WEEKS, THANK YOU. AND THEN ON ITEM NUMBER 9, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. AND ON ITEM NUMBER 12, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. THE REMAINING ITEMS ARE BEFORE YOU. 

SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. ANTONOVICH MOVES. KNABE SECONDS. WITHOUT OBJECTION, UNANIMOUS VOTE ON THE REMAINDER. 

CLERK SACHI HAMAI: ON ITEM NUMBER-- EXCUSE ME. ON PAGE 11, CONSENT CALENDAR, ITEMS 17 THROUGH 76, ON ITEM NUMBER 17, SUPERVISOR KNABE REQUESTS THAT THIS ITEM BE CONTINUED TO JUNE 6, 2012. 

SUP. YAROSLAVSKY, CHAIRMAN: WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: ON ITEM NUMBER 19, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NUMBER 23 AND ITEM NUMBER 24, THERE'S ALSO A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THESE ITEMS. ON ITEM NUMBER 30 AND 31, THERE'S A REQUEST FROM EITHER MEMBERS OR A MEMBER OF THE PUBLIC TO HOLD THESE ITEMS. ON ITEM NUMBER 41, THERE IS A REQUEST FROM MEMBERS OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NUMBER 43 AND 44, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THESE ITEMS. ON ITEM NUMBER 46, THERE'S ALSO A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NUMBER 54, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NUMBER 62, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NUMBER 68, SUPERVISOR KNABE REQUESTS THAT THIS ITEM BE CONTINUED TO JUNE 6, 2012. ON ITEM NUMBER 69, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NUMBER 72, AS INDICATED ON THE SUPPLEMENTAL AGENDA, THE ACTING COUNTY COUNSEL REQUESTS THAT THIS ITEM BE CONTINUED TO JUNE 6, 2012. AND ON ITEM NUMBER 74, THE ACTING COUNTY COUNSEL ALSO REQUESTS THAT THIS ITEM BE CONTINUED TO JUNE 6, 2012. THE REMAINING ITEMS UNDER THE CONSENT CALENDAR ARE BEFORE YOU. 

SUP. YAROSLAVSKY, CHAIRMAN: OKAY. ON THOSE THAT WERE REQUESTED TO BE CONTINUED, SO ORDERED. AND ON THE REMAINDER, SUPERVISOR RIDLEY-THOMAS MOVES. ANTONOVICH SECONDS; WITHOUT OBJECTION, UNANIMOUS VOTE. 

CLERK SACHI HAMAI: THANK YOU. ON PAGE 37, ORDINANCE FOR INTRODUCTION, ITEM NUMBER 77. ON THIS ITEM, SUPERVISOR KNABE REQUESTS THAT THE ITEM BE CONTINUED TO JUNE 6, 2012. 

SUP. YAROSLAVSKY, CHAIRMAN: WITHOUT OBJECTION, SO ORDERED. CAN I JUST ASK, MAKE SURE THAT THERE IS NO TIME DEADLINE ON THIS? THERE IS NO ISSUE? OKAY. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: DISCUSSION ITEMS, ITEMS NUMBER 78 AND 79, ON ITEM NUYMBER 78, WE WILL HOLD FOR A DISCUSSION. ON ITEM NUMBER 79, WE WILL HOLD FOR A PUBLIC HEARING. ON PAGE 38, MISCELLANEOUS ADDITIONS TO THE AGENDA WHICH WERE POSTED MORE THAN 72 HOURS IN ADVANCE OF THE MEETING AS INDICATED ON THE SUPPLEMENTAL AGENDA. ON ITEM NUMBER 80-A, THERE'S A REQUEST FROM MEMBERS OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NUMBER 80-B, SUPERVISOR ANTONOVICH WOULD ALSO LIKE TO MAKE A REVISION. AND HIS REVISION WOULD JUST SAY "AND ISSUE A WRITTEN REPORT IN TWO WEEKS TO THE OFFICE OF THE COUNTY COUNSEL IN ORDER THAT THE COUNTY'S LAWYERS MAY HAVE A CANDID AND CONFIDENTIAL REPORT OF THE FACTS UPON WHICH TO BASE THEIR LEGAL ADVICE TO THE BOARD." AND THEN THE REMAINING WOULD STAY THE SAME," THE WRITTEN REPORT SHALL INCLUDE" AND THE BULLETS THAT FOLLOW. SO ITEM NUMBER 80-B IS BEFORE YOU. 

SUP. YAROSLAVSKY, CHAIRMAN: WITHOUT OBJECTION, THE ITEM WILL BE AMENDED AS PROPOSED BY SUPERVISOR ANTONOVICH. THE ITEM IS BEFORE US. ANTONOVICH MOVES. I'LL SECOND IT. WITHOUT OBJECTION, UNANIMOUS VOTE. 

CLERK SACHI HAMAI: AND THAT COMPLETES THE READING OF THE AGENDA. BOARD OF SUPERVISORS SPECIAL ITEMS BEGIN WITH SUPERVISORIAL DISTRICT NUMBER 3. 

SUP. YAROSLAVSKY, CHAIRMAN: I'M VERY PLEASED THIS AFTERNOON TO INTRODUCE THE HONORABLE JESDA KATAVETIN, THE NEW CONSUL GENERAL OF THAILAND IN LOS ANGELES. THE CONSUL GENERAL COMES FROM A PUBLIC SERVICE AND DIPLOMACY. HE SERVED IN THE DEPARTMENT OF PROTOCOL IN THAILAND BEFORE BEING POSTED TO THE THAI EMBASSY IN AUSTRALIA AS SECOND SECRETARY. HE ROSE TO MORE SENIOR POSITIONS IN THE EMBASSY AND THEN RETURNED HOME TO BECOME FIRST SECRETARY IN THE DEPARTMENT OF ECONOMIC AFFAIRS. HE WENT ON TO SERVE IN THE DEPARTMENT OF INTERNATIONAL ORGANIZATIONS, MOVED ON TO BE APPOINTED COUNSELOR IN THE ADMINISTRATIVE AFFAIRS DIVISION THEN DIRECTOR OF THE DEVELOPMENT AFFAIRS DIVISION. HIS INTERNATIONAL POSTINGS RESUMED WITH HIS APPOINTMENT AS MINISTER COUNSELOR AT THE THAI EMBASSY IN INDONESIA. HIS SERVICE HAS BEEN RECOGNIZED WITH NUMEROUS DECORATIONS, MOST RECENTLY THE KNIGHT GRAND CROSS FIRST CLASS OF THE MOST NOBLE ORDER OF THE CROWN OF THAILAND. HE ARRIVED IN LOS ANGELES AFTER SERVING AS DEPUTY DIRECTOR GENERAL IN THE DEPARTMENT OF INFORMATION IN THAILAND. HE'S ALREADY ACQUAINTED WITH THE UNITED STATES AS HE EARNED HIS MASTER'S DEGREE IN POLITICAL SCIENCE AT CENTRAL MISSOURI STATE UNIVERSITY. ON BEHALF OF THE BOARD OF SUPERVISORS, CONSUL GENERAL, AND THE MORE THAN 10 MILLION RESIDENTS OF THE COUNTY OF LOS ANGELES, ALL OF US WANT TO EXTEND TO YOU A WARM WELCOME. AND KNOW THAT THE RELATIONSHIP BETWEEN OUR COUNTY AND THAILAND IS CLOSE AND RICH AND STRONG. WE HAVE MANY THAI RESIDENTS AND CITIZENS WHO LIVE HERE. AND MANY OF THEM IN MY OWN DISTRICT. AND THEY CONTRIBUTE GREATLY TO THE RICHNESS AND DIVERSITY OF OUR COUNTY. AND WE WELCOME YOU AND HOPE YOU'LL HAVE A GREAT STAY HERE IN LOS ANGELES AND DON'T MAKE YOURSELF A STRANGER TO OUR BOARD. I WANT TO PRESENT YOU WITH THIS PLAQUE FROM THE BOARD. AND ALSO A RENDERING OF THE SAN GABRIEL MISSION, WHICH IS THE FIRST MISSION IN THE COUNTY OF LOS ANGELES, OVER 200 YEARS AGO. SO I'LL HOLD IT IF YOU WOULD AND SAY A FEW WORDS AND WE'LL TAKE A PICTURE AFTERWARDS. 

CONSUL GENERAL, JESDA KATAVETIN: HONORABLE MEMBER OF THE BOARD OF SUPERVISORS, THANK YOU VERY MUCH FOR HONORING ME WITH A VERY WARM WELCOME. IT IS INDEED A PRIVILEGE AND GREAT HONOR. I'M PLEASED AND PROUD TO HAVE AN OPPORTUNITY TO BE PART OF CONSULAR CORPS IN LOS ANGELES COUNTY. THE LOS ANGELES COUNTY DOES NOT ONLY HAVE ONE OF THE LARGEST CONSULAR COMMUNITIES IN THE WORLD, IT IS ALSO A MELTING POT OF CULTURAL DIVERSITY AND HOME TO MANY ETHNIC COMMUNITIES, INCLUDING THAI, WHICH IS THE BIGGEST THAI COMMUNITY OUTSIDE THAILAND. BUT THEY ARE PROUD TO BE AMERICANS, THE THAI COMMUNITY IS ALSO ACTIVE IN PRESERVE AND PROMOTE THEIR OWN CULTURAL HERITAGE. THEY ARE HERE NOT ONLY TO LIVE THEIR LIVES AND EARN THEIR LIVING BUT ALSO TO PARTICIPATE, CONTRIBUTE AND GIVE BACK TO BOTH THE THAI AND AMERICAN SOCIETY. JUST A FEW WEEKS AGO, A RECOGNITION BY THE BOARD OF SUPERVISORS WAS GIVEN HERE IN THIS ROOM TO THE OUTSTANDING ACHIEVEMENT IN ORGANIZING ONE OF THE BIGGEST STREET FESTIVALS IN LOS ANGELES, THE SONGKRAN THAI NEW YEAR FESTIVAL IN THAI TOWN ON HOLLYWOOD BOULEVARD. THIS IS DEFINITELY A REWARD FOR ALL THE PEOPLE INVOLVED IN ORGANIZING THIS FESTIVAL FOR THE PAST NINE YEARS. IT IS ALSO AN ENCOURAGEMENT FOR THEM TO CONTINUE WORKING TO ADD TO THE CULTURAL DIVERSITY OF THE LOS ANGELES COUNTY AND TO BENEFIT LOCAL ECONOMY. FURTHERMORE, THE LOS ANGELES COUNTY IS ALSO KIND TO HAVE THE THAI AMERICAN VOTERS TO BE ABLE TO VOTE IN THAI LANGUAGE IN THE FIRST TIME IN THE UPCOMING ELECTIONS. THIS IS A HISTORIC MOMENT FOR ALL THAI AMERICANS. IT IS NOT ONLY BECAUSE THEY CAN VOTE IN THEIR OWN LANGUAGE, IT IS ALSO BECAUSE OF THE AVAILABILITY OF THAI VOTING BALLOTS HAS BEEN GIVEN THEM A STRONGER SENSE THAT THEY BELONG HERE AND THEY ARE AN INTEGRAL PART OF THE AMERICAN SOCIETY. WITH THIS I BELIEVE THEY WILL DO MORE IN TERMS OF CIVIC ENGAGEMENT AND POLITICAL PARTICIPATION. THEY WILL LEARN AND BE MORE APPRECIATED THE VALUES OF DEMOCRACY OF THIS GREAT NATION. ON BEHALF OF THE THAI COMMUNITY IN LOS ANGELES, I WISH TO EXPRESS MY DEEP APPRECIATION FOR ALL THIS THAI COOPERATION AND CONTINUED SUPPORT FROM THE LOS ANGELES COUNTY. I WOULD DO MY BEST IN MY TERM AS A CONSUL GENERAL TO CULTIVATE AND BUILD UP ON THIS TO FURTHER PROMOTE OUR FRIENDSHIP AND COOPERATION. THANK YOU VERY MUCH. [APPLAUSE.] 

SUP. YAROSLAVSKY, CHAIRMAN: NEXT IT'S MY PRIVILEGE BECAUSE WHEN YOU COME, YOU GET A BIG PLAQUE. WHEN YOU LEAVE, IT'S A MUCH SMALLER PLAQUE BECAUSE WE KNOW THE AIRLINES WON'T ALLOW YOU TO TAKE TOO MUCH WEIGHT. SO IT'S A PRIVILEGE TO WELCOME BACK AMBASSADOR BALAZS BOKOR, CONSUL GENERAL OF HUNGARY IN LOS ANGELES. THE CONSUL GENERAL HAS BEEN A RESIDENT OF LOS ANGELES SINCE HE WAS ACCREDITED TO HIS POST IN JUNE 2007, ALMOST FIVE YEARS. IN THE FIVE YEARS HE HAS BEEN WITH US, HE HAS ACTIVELY PROMOTED THE CULTURE OF HIS COUNTRY THROUGH NUMEROUS EVENTS ORGANIZED BY THE CONSULATE UNDER HIS LEADERSHIP. HE HAS ALSO LED THE ESTABLISHMENT OF INTERUNIVERSITY RELATIONS, JOINT RESEARCH PROJECTS AND STUDENT EXCHANGES. IN ADDITION TO HIS DUTIES IN LOS ANGELES COUNTY, HE HAS ALSO BEEN RESPONSIBLE FOR THE 19 WESTERN STATES, INCLUDING ALASKA AND HAWAII. HE WILL BE DEPARTING NEXT MONTH FOR HUNGARY WHERE HE EXPECTS TO SERVE AT THE MINISTRY OF FOREIGN AFFAIRS BEFORE HE STARTS A NEW FOREIGN ASSIGNMENT. WE WILL CERTAINLY MISS YOU. AND ON BEHALF OF THE 10 MILLION RESIDENTS OF OUR COUNTY AND OUR BOARD OF SUPERVISORS WE WANT TO WISH YOU CONTINUED SUCCESS IN YOUR DISTINGUISHED CAREER. I'VE HAD THE PRIVILEGE OF WORKING WITH YOU ON A FEW PROJECTS. YOU'VE BEEN A GREAT REPRESENTATIVE OF HUNGARY. AND HUNGARY IS A GREAT COUNTRY. I HAD THE PRIVILEGE OF VISITING IT SOME YEARS AGO. WE WISH YOU WELL IN YOUR RETURN HOME IN YOUR NEW ASSIGNMENT. [APPLAUSE.] 

CONSUL GENERAL, BALAZS BOKOR: HONORABLE SUPERVISORS, LADIES AND GENTLEMEN, IN FACT JUNE 17, 2007, FIVE YEARS AGO THAT WAS THE DATE WHEN I ARRIVED HERE IN LOS ANGELES. SINCE THE VERY FIRST MOMENT OF MY STAY HERE, I FELT AT HOME. I FELT THAT THE PEOPLE WHO DEALT WITH US WERE REALLY HOSPITABLE, REALLY FRIENDLY AND THEY MEANT THE COOPERATION, WHAT WE REALLY LOOKED FOR. I WAS VERY HAPPY FROM THE VERY FIRST MINUTE BECAUSE WHEN I FEEL HOME, I MEAN THAT THERE ARE APPROXIMATELY 80,000 HUNGARIAN AMERICANS LIVING IN LOS ANGELES COUNTY, WHICH IS A NICE NUMBER. WHEREVER I WENT, I FELT SOME HUNGARIAN SIGNS. I WENT TO THE EXPOSITION PARK. I SAW A GREAT HUNGARIAN LEADER'S CULTUREAL STATUE. I WENT TO THE MCARTHUR PARK, THE HUNGARIAN FREEDOM FIGHTERS OF 1956, A GREAT REVOLUTION. I WENT TO THE FILM STUDIO DISTRICT. I FOUND THAT THE MAJOR FOUNDING FATHERS OF THE MAJOR HOLLYWOOD STUDIOS, ALL THEY WERE COMING FROM HUNGARY. IF I RIDE ON THE WILSHIRE BOULEVARD, I SEE THE LONG BUSES, THE METRO BUSES, THE RED BUSES MANUFACTURED IN HUNGARY. AND I WILL NOT GO ON BECAUSE WE WILL STAY HERE FOR A COUPLE OF HOURS. ANYHOW, I FEEL VERY MUCH APPRECIATED. AND I WANT HONOR TO BE HERE. THANK YOU FOR THIS PLAQUE AND THROUGH FOR YOUR FRIENDSHIP AND COOPERATION. AND I FEEL THAT THIS IS THE WAY WE SHOULD GO WITH THE 80,000 HUNGARIANS LIVING IN LOS ANGELES COUNTY FOR THE FUTURE. THANK YOU VERY MUCH. [APPLAUSE.] JUST ONE MORE THING. BECAUSE YOU MENTIONED THE CULTURAL ASPECT OF OUR COOPERATION, SO MANY HUNGARIAN ARTISTS CAME HERE TO HAVE THEIR EXPOSITIONS AND EXHIBITIONS HERE IN LOS ANGELES. AND I WOULD LIKE TO GIVE ONE A NICE EXAMPLE TO THE BOARD OF SUPERVISORS. THIS IS FROM ___________ A VERY ANCIENT SUBJECT BUT I WOULD PUT IT MODERN SUBJECT, A HUNGARIAN MOTHER WITH A LOS ANGELES CHILD. [APPLAUSE.] 

SUP. YAROSLAVSKY, CHAIRMAN: SUPERVISOR KNABE? 

SUP. KNABE: THANK YOU, MR. CHAIRMAN. AT THIS TIME I WOULD LIKE TO ASK MEMBERS OF THE CULTURE SHOCK LOS ANGELES DANCE COMPANY TO JOIN ME UP HERE. CULTURE SHOCK L.A. IS A DANCE COMPANY THAT USES HIP HOP DANCE FORMS TO ENGAGE UNDERSERVED COMMUNITIES TO DEVELOP AND PRESENT HIGH QUALITY URBAN DANCE PERFORMANCES. FOR OVER 10 YEARS THEY HAVE CHALLENGED AND TRAINED DANCERS TO ACHIEVE THE HIGHEST LEVEL OF ARTISTIC SKILL AND CONTRIBUTE TO THE EVOLUTION OF OUR URBAN DANCE. THROUGH THEIR OUTREACH IN THEIR YOUTH ENGAGEMENT PROGRAMS, THEY HIGHLIGHT THE DIVERSITY AND CREATIVITY OF THE HIP HOP GENRE AND TEACH SELF-WORTH, RESPECT AND SELF-EXPRESSION TO YOUTH AND ADULTS RIGHT HERE IN OUR OWN LOS ANGELES COUNTY. 2012 MARKS THE FIFTH YEAR OF THEIR PARTICIPATION IN THE FOURTH SUMMER PARTNERSHIP PROGRAM. AND ON JUNE 22ND, THEY'RE GOING TO BE PERFORMING THEIR NEW WORK "BEAUTY" WHICH FUSES URBAN AND CLASSICAL DANCE STYLES, SPOKEN WORD AND MULTIMEDIA. CULTURE SHOCK L.A. WILL ALSO BE CONDUCTING HIP HOP WORKSHOPS ALL AROUND OUR COUNTY AS PART OF THE EXPANSION OF FORD THEATER'S JAM SESSIONS PROGRAM. THESE SESSIONS ARE COMPLETELY FREE AND ENGAGE PEOPLE OF ALL AGES, EXPERIENCE LEVELS AND BACKGROUNDS TO BECOME ARTISTS THEMSELVES AND PARTICIPATE IN EVERYTHING FROM HIP HOP AND DRUMMING TO BOLLYWOOD AND SAMBA. CULTURE SHOCK L.A.'S FIRST JAM WILL BE IN MAYBERRY PARK IN WHITTIER TUESDAY, JUNE 12, 6 TO 8 O'CLOCK. FOR MORE INFORMATION ON THIS PROGRAM, I WOULD ENCOURAGE EVERYONE TO VISIT THE FORD THEATER'S WEBSITE AT FORDTHEATERS.ORG. SO ON BEHALF OF MY COLLEAGUES AND THE BOARD, WE'D LIKE TO PRESENT THIS SCROLL AND COMMENDATION TO CULTURE SHOCK L.A. FOR THEIR ARTISTIC COLLABORATION WITH LOS ANGELES COUNTY PARTICULARLY FOR ENGAGING OUR YOUTH TO EXPRESS THEMSELVES AND BUILD SELF-RESPECT AND MUTUAL UNDERSTANDING. ACCEPTING ON BEHALF OF CULTURE SHOCK ARE COACTIVITY DIRECTORS ALLISON TANAKA AND MICHELLE COSTELLO. CONGRATULATIONS TO ALL, THANK YOU. [APPLAUSE.] WE HAVE LAURA ZUCKER WITH US, TOO, THE ONE AND ONLY. 

SPEAKER: ON BEHALF OF CULTURE SHOCK L.A. I'D LIKE TO THANK THE BOARD OF SUPERVISORS FOR HONORING US HERE TODAY. IT'S BECAUSE OF THE COUNTY'S SUPPORT, ESPECIALLY THE FORD THEATER'S, THE COUNTY ARTS COMMISSION AND SUPERVISOR KNABE'S ARTS EDUCATION PARTNERSHIP PROGRAM THAT WE'VE BEEN ABLE TO GROW ARTISTICALLY AS WELL AS GROW OUR EDUCATION AND OUTREACH PROGRAMS TO SERVE THOUSANDS OF YOUNG PEOPLE EACH YEAR. CULTURE SHOCK'S A VERY SPECIAL FAMILY OF DANCERS. THROUGH YOUR RECOGNITION HERE TODAY, IT FEELS LIKE YOU SORT OF VALIDATED AND HONORED ALL THE COUNTLESS HOURS OF HARD WORK THESE GUYS HAVE VOLUNTEERED OVER THE YEARS TO MAKE OUR PROGRAMS POSSIBLE. SO, AGAIN, THANK YOU FOR THIS OPPORTUNITY. AND ALSO THANK YOU FOR THE WORK THAT YOU DO TO ENSURE THAT THE ARTS REMAIN A VIBRANT AND VALUABLE PART OF THE LOS ANGELES COMMUNITY. SO WE HOPE TO SEE YOU ON JUNE 22ND AT OUR SHOW AT THE FORD AND ALSO AT THE JAM SESSIONS WE'LL BE HOSTING AT EACH OF THE DISTRICTS COMING UP. SO VISIT FORDTHEATERS.ORG AND FORDJAMSESSIONS.ORG FOR THE SCHEDULE, THANK YOU. 

SUP KNABE: AND NO SALESMAN WILL CALL. LAURA, DO YOU WANT TO ADD ANYTHING? 

LAURA ZUCKER: NO, THAT WAS PERFECT. 

SUP. ANTONOVICH: I'M GOING TO GO BACK TO HUNGARY. TODAY WE CELEBRATE THE 200TH ANNIVERSARY OF THE BIRTHDAY OF COUNT AGOSTON HARASZTHY WHO IS THE FOUNDER OF THE CALIFORNIA WINE INDUSTRY. HE WAS A HUNGARIAN AMERICAN WHO HAD IMMIGRATED FROM BUDAPEST TO NEW YORK IN 1840, THE FIRST HUNGARIAN TO SETTLE PERMANENTLY IN THE UNITED STATES. HE WAS A WORLD TRAVELER, WRITER, TOWN BUILDER AND PIONEER WINE MAKER. HE MADE HIS HOME IN WISCONSIN WHERE HE WAS ONE OF THE FIRST TO PLANT VINEYARDS. THERE HE ALSO FOUNDED WISCONSIN'S FIRST INCORPORATED TOWNSHIP. HE MOVED TO SONOMA, CALIFORNIA, WHERE HE FOUNDED THE BUENA VISTA VINEYARDS AND WAS AN EARLY EXPERT WRITER ON CALIFORNIA WINE AND CULTURE. HE INTRODUCED CALIFORNIA TO MORE THAN 300 VARIETIES OF EUROPEAN GRAPES. HIS WORK EARNED HIM THE TITLE OF FATHER OF MODERN WINE MAKING IN CALIFORNIA. SO TODAY WE HAVE WITH US ONCE AGAIN THE CONSUL GENERAL FOR HUNGARY AND WE CONGRATULATE HIM ONCE AGAIN ON HIS WONDERFUL SERVICE DURING THIS PAST FOUR YEARS. I WOULD SAY THAT CONSUL GENERAL ATTENDED MANY COMMUNITY EVENTS AND WAS QUITE INVOLVED AND WE APPRECIATED HIS LEADERSHIP. WE HAVE ANDREW FRIEDMAN, LOS ANGELES COUNTY COMMISSIONER. FRANK _________ III THE ADC COORDINATOR ___________ HARASZTHY I'M GOING TO MISPRONOUNCE THAT OF THE FAMILY WINERIES IN SONOMA. GEORGE WEBER, CHAIRMAN OF CITY OF SONOMA. TOKAJ, HUNGARY'S SISTER CITY COMMITTEE, WHICH IS CELEBRATING THE BICENTENNIAL. MIKLOS PEREHAZY, PRESIDENT OF HUNGARIAN HOUSE OF LOS ANGELES AND GEORGE ________ OWNER OF THE AMERICAN HUNGARIAN DAIRY PERIODICAL LOS ANGELES. SO ON BEHALF OF THE 200TH ANNIVERSARY, HAPPY BIRTHDAY. 

ACTOR PORTRAYING AGOSTON HARASZTHY: HONORABLE MEMBERS OF THE LOS ANGELES COUNTY BOARD OF SUPERVISORS, AMBASSADOR BOKOR, DR. FRANK _________, MR. MIKLOS PEREHAZY, MR. GEORGE _______, LADIES AND GENTLEMEN, MEMBERS OF THE PRESS, I AM OVERJOYED TO STATE MY COMPLETE HAPPINESS AT HAVING RETURNED TO CORPOREAL FORM AND BEING PRESENT HERE TODAY TO HONOR THE MAN WHOSE PERSONALITY I HAVE COME TO INHABIT: COUNT AUGOSTON HARASZTHY. HAVING BEEN BORN IN AUGUST 30, 1812 AND THUS ALMOST REACHING MY 200TH BIRTHDAY, IT IS COMPLETELY JUST AND FITTING THAT I STAND BEFORE YOU TODAY. IT IS WHOLLY PLEASANT TO RETURN TO THE HOME OF MY GOOD FRIEND JEAN-LOUIS __________WHO I VISITED AT HIS VINEYARD _________ HERE IN LOS ANGELES IN 1850, HAVING ARRIVED IN DECEMBER OF 1849 IN SAN DIEGO OVER LAND FROM WISCONSIN. JEAN-LOUIS ENCOURAGED ME IN THE BELIEF THAT FINE EUROPEAN WINE COULD BE MADE IN CALIFORNIA, AND SO IT CAME TO BE. IT WAS IN SONOMA, I FOUND THE PERFECT WINE VALLEY, OF COURSE, AND I FOUNDED BUENA VISTA WINERY IN 1857, THE SUCCESS OF WHICH FINALLY BROUGHT FORTH THE TITLE I AM GRATEFUL TO BEAR WITH HONOR TODAY, "THE FATHER OF CALIFORNIA VITICULTURE". PERHAPS HUNGARIANS AND FRENCH MEN ARE BOTH NECESSARY TO MAKE FINE EUROPEAN WINE IN AMERICA. THIS SUPPOSITION MADE MANIFEST IN THE CURRENT DAY BY THE APPEARANCE OF JEAN-CHARLES BOISSET THE FRENCH MAN WHO HAS TAKEN THE WORLD OF CALIFORNIA WINE BY STORM MUCH AS I DID 150 YEARS AGO. I AM GRATEFUL HE IS NOW RESTORING BUENA VISTA TO ITS RIGHTFUL POSITION AS THE FINEST COLLECTION OF 1860 STONE WINERY BUILDINGS IN CALIFORNIA. I WANT TO OFFER A SPECIAL THANKS TO AMBASSADOR BOKOR WHO I AM PRIVILEGED TO NOW REGARD AS A PERSONAL FRIEND. HIS REMARKABLE LEADERSHIP HAS MEANT MUCH TO HUNGARIANS IN THE WESTERN UNITED STATES. SEPTEMBER FIRST, THE SONOMA PLAZA WILL BE A MAGNIFICENT DAY WHERE THE OFFICIAL DOCUMENTS WILL BE SIGNED MAKING TOKAJ AND SONOMA SISTER CITIES, TWO WINE COUNTRY LEGENDS BOUND TOGETHER FOREVER IN FRIENDSHIP AND CITIZEN DIPLOMACY. I BRING GREETINGS FROM THE MAYOR SANDERS OF SONOMA AND THE SONOMA CITY COUNCIL AND CONSIDER MY APPEARANCE HERE A SINGULAR HONOR. I THANK YOU. IT WOULD BE REMISS TO NOT MENTION, FINALLY, THAT MY FAMILY DID BESTOW UPON YOUR FINE CITY A MOST THE REMARKABLE WOMAN, MY DAUGHTER IDA. HAVING MARRIED MAJOR HENRY HANCOCK IN 1863, SHE BECAME A SINGULAR MEMBER OF THE LOS ANGELES COMMUNITY. AND I NEED NOT REMIND YOU OF HER MANY FINE CONTRIBUTIONS TO CIVIC AND CULTURAL LIFE. I THANK YOU ONCE AGAIN WITH GREAT AFFECTION FOR THIS CITY OF THE ANGELS. I AM COUNT AGOSTON HARASZTHY. [APPLAUSE.] 

SUP. ANTONOVICH: TODAY WE'RE GOING TO HONOR DR. HOWARD SUNDBERG WHO HAS SERVED OUR LANCASTER SCHOOL DISTRICT FOR THE PAST 26 YEARS. HE BEGAN WITH THE LANCASTER SCHOOL DISTRICT AS A PRINCIPAL BACK IN 1986 SERVING AS THE DIRECTOR OF CURRICULUM AND INSTRUCTION, THE DIRECTOR OF SPECIAL PROGRAMS AS THE ASSISTANT SUPERINTENDENT OF EDUCATIONAL SERVICES. THE PAST SIX YEARS HE'S BEEN THE SUPERINTENDENT OF THE LANCASTER SCHOOL DISTRICT, A UNIVERSITY OF MINNESOTA WILLIAMS SCHOLAR COAUTHORED "THE CAREER EDUCATION FRAMEWORK," "ANTELOPE VALLEY: BRIDGE FROM EDUCATION TO CAREERS," A K-14 PLAN WHICH RECEIVED STATE RECOGNITION. ALSO AUTHORED PROFESSIONAL JOURNAL ARTICLES ON EDUCATION LEADERSHIP AND PHYSICAL EDUCATION, RECEIVING BOTH HIS BACHELOR'S AND MASTER'S DEGREE FROM AZUSA PACIFIC UNIVERSITY. HE RECEIVED HIS PH.D FROM THE UNIVERSITY OF CALIFORNIA SANTA BARBARA IN ORGANIZATIONAL POLICY AND ORGANIZATION. HE'S BEEN A PAST MEMBER OF THE LANCASTER VETERANS' HOME CITIZENS COMMITTEE, PRESIDENT OF THE ANTELOPE VALLEY UNIT OF THE AMERICAN CANCER SOCIETY, MEMBER AND PAST DIRECTOR OF THE GRACE LUTHERAN CHURCH AND MEMBER OF THE ANTELOPE VALLEY YMCA LEADERSHIP BOARD. SO, DOCTOR, THANK YOU VERY MUCH FOR YOUR LEADERSHIP. 

DR. HOWARD SUNDBERG: I'D LIKE TO THANK THE BOARD OF SUPERVISORS FOR THIS RECOGNITION. I APPRECIATE IT VERY MUCH. IT'S A LONG WAY FROM A NORTH COUNTY POSITION OF A LITTLE KID RUNNING AROUND IN THE DESERT TO BEING HERE BEFORE THIS AUGUST BODY. AND I APPRECIATE THE RECOGNITION AND I ESPECIALLY THANK SUPERVISOR ANTONOVICH FOR HIS ONGOING SUPPORT OF EDUCATION IN ANTELOPE VALLEY. [APPLAUSE.] 

SUP. ANTONOVICH: TODAY IS THE 63RD REGIONAL SUPPORT COMMAND. WE INTRODUCED THE UNITED STATES ARMY REGIONAL SUPPORT COMMAND LIEUTENANT COLONEL RAYMOND ______ AND MR. W.R. JONES. BILL DIDN'T COME, OKAY? THIS IS THE REGIONAL SUPPORT COMMAND WHO IS RESPONSIBLE FOR THE BASE ADMINISTRATIVE COMMAND OF ALL ARMY RESERVE UNITS AND OVER 40,000 SOLDIERS THROUGHOUT THE SEVEN-STATE REGION OF THE SOUTHWESTERN UNITED STATES INCLUDING CALIFORNIA, NEVADA, ARIZONA, NEW MEXICO, OKLAHOMA, TEXAS AND ARKANSAS. OVER THE PAST DECADE, THE RESERVISTS HAVE TRANSFORMED TO AN OPERATIONAL FORCE. THE SOLDIERS AND THEIR FAMILIES OF THE ARMY RESERVE HAVE FACED THE HARSH REALITY OF MULTIPLE COMBAT DEPLOYMENT AND OTHER LONG TERM SEPARATIONS. TWO YEARS AGO, THE 63RD IMPLEMENTED A COMPREHENSIVE YELLOW RIBBON REINTEGRATION PROGRAM ADDRESSING THE CRITICAL NEEDS OF SOLDIERS AND FAMILIES GOING THROUGH EACH PHASE OF THE DEPLOYMENT. SINCE ITS INCEPTION, MORE THAN 10,000 MILITARY PERSONNEL AND THEIR FAMILIES PARTICIPATED IN THESE WORKSHOPS. THE YELLOW RIBBON PROGRAM TEACHES SOLDIERS AND THEIR FAMILIES TOOLS AND IDENTIFIES VALUABLE RESOURCES TO HELP THEM PREPARE FOR, COPE WITH AND REINTEGRATE INTO FOLLOWING DEPLOYMENTS. THIS WEEKEND, THE 63RD WILL HOST A SPECIAL YELLOW RIBBON PROGRAM SALUTING THE SERVICE AND SACRIFICE OF SOLDIERS AND FAMILIES AND ALSO CELEBRATE THE ARMY'S 237TH BIRTHDAY. SO IT'S MY HONOR TO PRESENT THIS TO THE UNITED STATES ARMY SUPPORT COMMAND. [APPLAUSE.] 

SPEAKER: THANK YOU VERY MUCH. 

SUP. ANTONOVICH: THE COLONEL CAME OUT OF UNIFORM TODAY. 

SPEAKER: THANK YOU VERY MUCH FOR EVERYTHING THAT YOU DO IN ORDER TO SUPPORT THE TROOPS AND THEIR FAMILY MEMBERS. DEPLOYMENT IS SOMETHING THAT AFFECTS SERVICE MEMBERS AND THEIR FAMILIES IN A VERY NONTRADITIONAL WAY. PEOPLE GO TO DEPLOYMENT AND THEY COME BACK DIFFERENT. THE YELLOW RIBBON REINTEGRATION PROGRAM IS REALLY ALL ABOUT HELPING THEM TO DISCOVER THEIR NEW NORMAL. IT'S REALLY NOT GOING BACK TO REDISCOVER THE PAST AND TRY TO DO THINGS THE WAY THEY WERE DONE BEFORE THE DEPLOYMENT, BUT WAR CHANGES PEOPLE. BUT THE BIG THING ABOUT WHAT WE DO IS BECAUSE OF PEOPLE LIKE YOU WHO SUPPORT OUR PROGRAM, WHO SUPPORT OUR SERVICE MEMBERS AND THEIR FAMILIES, BECAUSE OF WHAT YOU DO, OUR SERVICE MEMBERS DO WHAT THEY DO. WITHIN THE HEART OF A SOLDIER IS A HEART OF A CITIZEN. AND WE ARE THANKFUL AND WE'RE GRATEFUL TO HAVE SOLDIERS AND CITIZENS WHO WORK TOGETHER TO NOT ONLY PROTECT OUR COUNTRY BUT TO REPRESENT OUR COUNTRY. AND AS THEY DO WHAT THEY DO, THEY REPRESENT YOU. AND THEY REPRESENT YOU WITH HONOR. AND AS YOU DO WHAT YOU DO, YOU REPRESENT THEM. AS WE COME TOGETHER AND WE REPRESENT ONE ANOTHER AND WE TIE TOGETHER, THERE ARE SO MANY MORE THINGS THAT WE CAN DO. SO IT'S OUR PLEASURE, IT'S OUR PRIVILEGE AND IT'S OUR HONOR THAT EVERY TIME WE HOST A SERVICE MEMBER OR A FAMILY MEMBER IN THE YELLOW RIBBON PROGRAM, WE'RE ACTUALLY HOSTING YOU BECAUSE WE'RE REPRESENTING THE BEST OF WHO YOU ARE. WE'RE REPRESENTING THE BEST OF WHERE YOU CAME FROM. AND WE HAVE SEVEN STATES WHERE WE CAN DO OUR EVENTS. BUT WE ENSURED WHEN WE COME TO THIS REGION WHEN WE DO OUR EVENT BECAUSE WE KNOW OF THE PROFOUND SUPPORT THAT YOU OFFER TO OUR SERVICE MEMBERS AND THEIR FAMILIES. WE THANK YOU AS YOU THANK OUR TROOPS. WE HONOR YOU AS YOU HONOR OUR TROOPS. IT MEANS THE WORLD TO US TO BE ABLE TO REPRESENT YOU IN SUCH AN ASTOUNDING MANNER. SO WE'RE GRATEFUL TO RECEIVE THIS PROCLAMATION TODAY. BUT WE GIVE IT BACK TO YOU IN OUR HEARTS BECAUSE WE REPRESENT THE WHOLE OF WHO YOU ARE. SO THANK YOU FOR YOUR SUPPORT. THANK YOU FOR SUPPORTING OUR SERVICE MEMBERS. AND WHENEVER YOU SEE THEM, WHENEVER YOU HEAR OF THEM, WHENEVER YOU HEAR ANYTHING ABOUT THEM OR YOU ARE IN THEIR PRESENCE, REMEMBER TO THANK THEM AND TO REGARD THEM NOT SIMPLY BECAUSE OF THEIR POLITICAL STANDING OR BECAUSE OF THE UNIFORM THAT THEY WEAR BUT BECAUSE THEY REPRESENT YOU. AND AS THEY REPRESENT YOU, THEY REPRESENT THE BEST OF WHO YOU ARE. SO THANK YOU VERY MUCH AND THANK YOU FOR THIS OPPORTUNITY. [APPLAUSE.] 

SUP. ANTONOVICH: NOW WE HAVE A LITTLE MIX. THIS IS STEVIE. 12 WEEKS OLD. LITTLE STEVIE LOOKING FOR A HOME. WE'D LIKE TO ADOPT LITTLE STEVIE. YOU CAN CALL 562-728-4644 OR ANYBODY IN THE AUDIENCE WOULD LIKE LITTLE STEVIE? LOOKING FOR A LITTLE HOME. HOW ABOUT YOU? WOULD YOU LIKE TO GO TO VENTURA COUNTY WITH SACHI? HAVE HER IN A CAR WHEN YOU DRIVE EVERY DAY? WHAT DO YOU THINK? DOCTOR, HOW ABOUT FOR LANCASTER? NOW THAT YOU'RE RETIRING FROM THE SCHOOL DISTRICT? LITTLE STEVIE CAN RUN AROUND AND KEEP YOU COMPANY. 

SUP. YAROSLAVSKY, CHAIRMAN: IS THAT IT? OKAY. THAT CONCLUDES OUR PRESENTATIONS. WE'LL GO TO PEOPLE WHO HAVE SIGNED UP ON AGENDA ITEMS IN MULTIPLE NUMBERS. DR. CLAVREUL HAS ASKED TO BE HEARD ON ITEM 3, 30, 31 AND 41. ARNOLD SACHS HAS ASKED TO BE HEARD ON ITEM 3, 9, 23, 41, 46, 54, 69, 78 AND 80-A. AND ERIC PREVEN HAS ASKED TO BE HEARD ON ITEMS 3-P, 3, 12, 19, 24, 30, 43, 44, 62, 78 AND 80-A. SO IF THEY CAN ALL COME DOWN HERE. DR. CLAVREUL, BRING THE MICROPHONE DOWN, THANK YOU. GOOD AFTERNOON. 

DR. GENEVIEVE CLAVREUL: GOOD AFTERNOON, BOARD OF SUPERVISORS, DR. GENEVIEVE CLAVREUL. IT WOULD BE NICE IF YOU REALLY FOLLOW THE BROWN ACT AND DON'T HAVE TO SPEAK TO ALL ITEMS AT THE SAME TIME. BUT I WILL SPEAK NONETHELESS. AND ON THE FIRST ITEM, PERSONALLY I DO NOT LIKE TO SEE THE NAME OF ANY LIVING PEOPLE PUT ON THE NAME OF STREETS. AND I THINK OF ALL PEOPLE, DR. BURKE IS THE LEAST PERSON WHO SHOULD GET A STREET NAMED AFTER HIM. I THINK THIS COUNTY, HE HAS MADE A LOT OF MONEY ON THE COUNTY'S BACK FOR A LONG TIME. AND I FEEL THAT TO HAVE A STREET NAMED AFTER HIM IS APPALLING. 

SUP. KNABE: IT'S NOT A STREET. 

DR. GENEVIEVE CLAVREUL: LET'S NOT ANY KIND OF IN HIS NAME IS AN INSULT TO PEOPLE WHO ARE TRULY A HERO AND DESERVE SOME RECOGNITION. BUT PERSONALLY I THINK A LIVING PERSON SHOULD NOT GET NOTHING NAMED AFTER THEM. THAT'S MY, YOU KNOW, POINT OF VIEW. AND ON ITEM 30, AGAIN WE ARE HAVING A HUGE AMOUNT BEING PAID TO CONSULTANTS. WE'RE HAVING 1,251,000 BEING PAID TO PAY CONSULTANT FOR THE TRANSITION AT HARBOR U.C.L.A. AND I THINK WE HAVE SPENT A GOOD AMOUNT OF MONEY TO MAKE THOSE REPAIRS AT HARBOR U.C.L.A. AND I THINK THE FIRM YOU HAVE HIRED SHOULD HAVE BEEN QUALIFIED TO ALSO DO THE TRANSITION AND TO PAY THE EXTRA IS KIND OF RIDICULOUS. ALSO ITEM I HAD HELD IS THE ITEM HAVING TO DO WITH HIV AND AIDS CONTRACT, ITEM NUMBER 41. AND WE ARE AT THE SAME STAGE WE ARE ALL THE TIME. WE DID NOT HAVE TIME TO SENSOR OUR R.F.P., SO CONSEQUENTLY WE GO TO DO THE SOLE VENDOR CONTRACT AND WE GO TO USE THE SAME PEOPLE WE HAVE USED FOREVER. THAT HAS BEEN GOING ON. I HAVE BEEN MONITORING THE BOARD SINCE 1999 AND I HAVE SEEN THAT STORY ESPECIALLY ABOUT HIV AND AIDS COMING BACK EVERY YEAR. THERE IS NO REASON WHY THE R.F.P. ARE NOT SENT IN TIME EXCEPT IF YOU WANT TO FAVOR SOME SPECIFIC VENDOR. AND I THINK THAT NEEDS TO STOP AT SOME TIME. BUT THANK YOU VERY MUCH. 

SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU, DR. CLAVREUL. 

DR. GENEVIEVE CLAVREUL: I HAVE A QUESTION FOR YOU, SUPERVISOR ZEV. TWO BOARD MEETINGS AGO YOU TOLD MR. NAHHAS THAT YOU WOULD CHECK ABOUT THE BROWN ACT VIOLATION OF NOT ALLOWING HIM TO PHOTOGRAPH DURING THE MEETING. YOU NEVER CAME BACK WITH A RESOLUTION OR A FINDING. I WOULD LIKE VERY MUCH FOR YOU TO DO THAT. 

SUP. YAROSLAVSKY, CHAIRMAN: I WILL. THANK YOU FOR REMINDING ME. AND I AM AWARE THAT YOU DID HAVE YOUR VIDEO CAMERA THERE. WE HAVE NOT GOTTEN A RESPONSE YET, BUT WE WILL. 

ERIC PREVEN: ARE YOU AUTHORIZING A LEAPFROG MOMENT OR SHOULD MR. SACHS STEP IN, SIR. 

SUP. YAROSLAVSKY, CHAIRMAN: MR. PREVEN, YOU ARE ON NEXT. 

ERIC PREVEN: AS YOU RECALL, MY NAME IS ERIC PREVEN AND I AM THE COUNTY RESIDENT FROM DISTRICT 3. TO BE FAIR, SUPERVISOR KNABE IS CORRECT. ITEM 3 IS A PROMENADE ALONG THE WATERSIDE IN MARINA DEL REY, IT IS CERTAINLY NOT A STREET. AND TO THINK THAT NAMING HIM AFTER A PROMENADE WOULD HAVE THE SAME EFFECT AS WELL, PERFECTLY REASONABLE. ON ITEM JUST TO FINISH OFF WITH THE MARINA BRIEFLY, ITEM NUMBER 62 I THINK A MEASURE OF THANKS IS IN ORDER BECAUSE WE ARE RELOOKING AT SOME MANHOLE COVER, MANHOLE LININGS THAT WE HAVE BEEN LOOKING AT. I THINK I BROUGHT IT TO THE BOARD'S ATTENTION THAT IT WAS 475,000 IN 2010. IT JUMPED UP TO 600 AND CHANGE. WE'RE GOING TO PUT THAT OUT TO FURTHER R.F.P. TO SEE IF WE CAN TIGHTEN THAT SPREAD. THANK YOU, MR. FUJIOKA AND THANK YOU, GAIL FARBER FOR THAT. FINALLY, NOT FINALLY, ITEM 19 IS NOT THE MARINA, IT'S THE LEGACY PARTNERS. IT'S A LARGE GROUP. IN THIS CASE THEY'RE DOWN IN LONG BEACH. AND I CAN'T FIGURE OUT. THIS IS FOR MENTAL HEALTH OFFICE SPACE. AND THEY SEEM TO BE ONCE AGAIN, CONGRATULATIONS, MR. FUJIOKA, ROLLING BACK WHAT THEY HAVE BEEN CHARGING US. BUT THIS IS ALSO A GROUP THAT HAS SOME BUSINESS IN THE COUNTY. IT'S HARD FOR ME TO KEEP TRACK IN LIGHT OF THE FACT THAT WE ARE BUILDING WITH LONG BEACH JUDICIAL PARTNERS LLC, A NEW FACILITY EXACTLY WHAT IS GOING ON THERE. THAT IS GOOD NEWS. WE'LL TAKE IT WHEN WE CAN GET IT. 80-A, VERY BRIEF COMMENT. THIS IS SUPERVISOR YAROSLAVSKY WHO IS IN OPPOSITION TO SOME LEGISLATION THAT WOULD, AND I'M QUOTING HERE, "MAKE THE COUNTY'S LAND USE HEARINGS LESS ACCESSIBLE TO MEMBERS OF THE PUBLIC". SO, SIR, THANK YOU. THIS IS REALLY QUITE SURPRISING COMING FROM THE MAN WHO PUSHED THE RULE TO SHORTEN PUBLIC COMMENTS HERE AT BOARD MEETINGS IN EFFECT AND HAD IT PASS AND THEN WENT FORWARD WITH IT WITH NO APPROVAL. SO THANK YOU FOR REACHING IN THE DIRECTION OF THAT. ITEM NUMBER 3-P IS SOMETHING THAT OF COURSE EVERYBODY WOULD SUPPORT. FIXING UP A REC CENTER IN THE ROSEMEAD COMMUNITY REC CENTER. THEY'RE ADDING 25 COMPUTERS. I THINK A BUDGET FOR A 500,000 DOLLAR EXPENDITURE COULD LET US SORT OF SEE, THE PUBLIC, THAT IS, HOW THE MONEY IS BEING DEPLOYED. AND THAT WOULD BE IN EVERYBODY'S INTERESTS. ITEM NUMBER 12 IS ANOTHER-- THIS IS MANAGEMENT WEEK, BY THE WAY, SO I THINK FOR ALL OF US WHO ARE MANAGERS, THAT'S GOOD NEWS. AND CONGRATULATIONS. ITEM NUMBER 12 IS A SLIGHT UPGRADE. IT'S ACTUALLY DESCRIBED AS A SALARY SUPPLEMENT FOR THE GUY WHO'S MANAGING THE FORD THEATER FOUNDATION FOR US. BUT THERE'S NOWHERE IN THAT ITEM IS THE DOLLAR AMOUNT THAT HE IS RECEIVING ON TOP OF HIS REGULAR COMPENSATION. THAT WOULD BE ALSO IN THE INTEREST OF PUBLIC SCRUTINY. THOUGH IT'S GOOD TO KNOW HE'S GIVEN A LITTLE MORE TO MANAGE 150,000, WE'RE NOT SURE. NOW ITEM NUMBER 43, MY FINALIZED, MY LAST ONE IS AMERICAN GOLF CORPORATION MERCIFULLY IS COMING IN TO RESCUE US FROM A BAD SITUATION, AND THEY ARE TAKING OVER THE EL CARISO COUNTY GOLF COURSE FOR US. NOW, THE ONLY THING IS THERE WAS NO R.F.P., AND AS I UNDERSTAND IT THERE IS NOT GOING TO BE AN R.F.P. I WAS WONDERING IF WE COULD SOMEHOW BUILD INTO THAT THE OPPORTUNITY FOR OTHER BIDDERS TO HAVE A CHANCE. BECAUSE WE DID A SHORT PHONE CALL, BUT WE DIDN'T HAVE A PROPER R.F.P. 

SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. MR. SACHS? 

ARNOLD SACHS: YES, THANK YOU. GOOD AFTERNOON. ARNOLD SACHS. I, TOO, HELD ITEM 3. I WAS JUST WONDERING: WOULD THAT SIGNAGE INCLUDE DR. WILLIAM BURKE BRATWORTH? BUT MORE IMPORTANTLY FOR THE AMOUNT OF WORK AND THE WAY THAT HE ACTUALLY HELPED TO RAPE THE CITY OF L.A. WITH THE L.A. MARATHON, LET ME READ VERY QUICKLY AN ITEM FROM ONE OF THE MEETINGS, "ANOTHER ISSUE WHICH HAS BEEN RESOLVED IS THE PAYMENT OF AMOUNTS OWED TO BURKE AND MARIE PATRICK, SHAREHOLDERS IN LOS ANGELES MARATHON, THE ORIGINAL CONTRACTOR WITH THE CITY TO ORGANIZE A MARATHON. THE LOS ANGELES MARATHON WAS SELECTED THROUGH A COMPETITIVE PROCESS IN 1985 AND WAS SUBSEQUENTLY SOLD TO DIVINE. DR. BURKE AND MISS PATRICK CONTINUE TO MANAGE THE MARATHON ON BEHALF OF DIVINE." SO NOT ONLY DID HE OWN STOCK IN THE COMPANY THAT RAN THE MARATHON, THEN HE EVENTUALLY ENDED UP GETTING PAID TO MANAGE THE MARATHON BY THE COMPANY THAT HE OWNED STOCK IN. THEN HE GOT PAID FOR THAT AND HE GOT PAID FOR THE INTELLECTUAL VALUE. NOT BAD WORK IF YOU CAN GET IT. BUT LET'S HONOR HIM WITH A STREET. NOW, I HELD ITEM NUMBER 23 BECAUSE IT'S A BUSINESS IMPROVEMENT DISTRICT. AND AGAIN MY CONCERNS OF BUSINESS IMPROVEMENT DISTRICTS SEEMS TO BE MANAGED IN THE CITY OF L.A. BY NONPROFITS. BUT THE NONPROFITS ARE MANAGED BY FOR-PROFITS. AND THERE GOES THE MONEY, AND THE AMOUNT OF MONEY CONCERNED. THE DOWNTOWN BUSINESS IMPROVEMENT DISTRICT HAS ALMOST 32 PERCENT OF ITS MONEY IN MANAGEMENT. IT'S LIKE 20 PERCENT HIGHER THAN WHAT A GOOD NONPROFIT SHOULD DO. 41 I HELD MENTIONS NONCOMPETITIVE BIDS. AND I KNOW HOW WONDERFULLY YOU THINK ABOUT NONCOMPETITIVE BIDS. I HELD ITEM 46 BECAUSE IT REFERS TO HAWTHORNE BOULEVARD. AND IN A RELATED ACTION, YOU MIGHT HAVE READ WHERE DISNEY HAS JUST RAISED THE PRICE OF ITS PASS FROM LIKE 460 TO 660. BUT IF YOU REALLY WANT TO SAVE SOME MONEY, TAKE THE BUS, TAKE THE 740 ON HAWTHORNE BOULEVARD FROM GOING JUST NORTH, CROSSING CENTURY BOULEVARD, YOU CAN RIDE IT TWICE FOR ONE DOLLAR FIFTY EACH WAY. IF YOU OPEN YOUR EYES, IT'S A WONDERFUL RIDE BECAUSE YOU FEEL LIKE YOU'RE ON A ROLLER COASTER. AND IF YOU CLOSE YOUR EYES, IT WILL BE LIKE BEING ON SPACE MOUNTAIN ON THE SAME ROLLER COASTER. I HELD ITEM 54 FOR RED LIGHT CAMERAS. I'M WONDERING WHY THE COUNTY HAS A RED LIGHT CAMERA PROGRAM THAT IS ABLE TO BE ENFORCED BY COURTS AND THE CITY OF L.A. IN THE SAME COUNTY HAD TO DISCONTINUE ITS RED LIGHT PROGRAM BECAUSE THE COURTS WOULDN'T ENFORCE THE VIOLATIONS. IT JUST DID NOT MAKE SENSE. AND I HELD ITEM 69 BECAUSE OF THE COUNTY COUNSEL. THE COUNTY COUNSEL'S ALSO THE COUNSEL FOR NOT ONLY THE BOARD OF SUPERVISORS BUT THE JAIL COMMISSION, THE M.T.A., AND THE COLISEUM COMMISSION. THE LATTER TWO GROUPS NOT BEING COUNTY ORGANIZATIONS. HOW COME THE COUNTY COUNSEL IS REFERRED LIKE THAT? 

SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU, MR. SACHS. 

ARNOLD SACHS: THANK YOU, SIR. 78 ITEMS 2-1/2 MINUTES. 

CLERK SACHI HAMAI: THERE IS A NUMBER OF ITEMS THAT ARE BEFORE YOU NOW. 

SUP. YAROSLAVSKY, CHAIRMAN: YES, GO AHEAD. 

CLERK SACHI HAMAI: ITEM NUMBER 3-P, 3, ITEM NUMBER 6, JUST FOR THE RECORD, WE'LL CONTINUE FOR THREE WEEKS TO JUNE 19TH, ITEM NUMBER 9, 12, 19-- 

SUP. YAROSLAVSKY, CHAIRMAN: THAT WAS SUPERVISOR ANTONOVICH'S MOTION, CORRECT? 

CLERK SACHI HAMAI: YES. ITEM NUMBER 6 CONTINUED FOR THREE WEEKS. 

SUP. YAROSLAVSKY, CHAIRMAN: FOR THREE WEEKS, YES, OKAY, THAT'S FINE. 

CLERK SACHI HAMAI: ITEM NUMBER 9, 12, 19, 23, 24, 30, 31, 41, 43, 44, 54, 62, 69 AND 80-A ARE BEFORE YOU. 

SUP. YAROSLAVSKY, CHAIRMAN: SUPERVISOR KNABE MOVES. ANTONOVICH SECONDS. WITHOUT OBJECTION, UNANIMOUS VOTE. 

CLERK SACHI HAMAI: THANK YOU. 

SUP. YAROSLAVSKY, CHAIRMAN: WE ARE AT ITEM NUMBER 2, AS WELL, THAT SOMEBODY ASKED TO BE HEARD ON? ARTURO CERVANTES? 

ARTURO CERVANTES: GOOD AFTERNOON, MEMBERS OF THE BOARD, MY NAME IS ARTURO CERVANTES I'M WITH THE CITY OF PICO RIVERA. I'M THE DIRECTOR OF PUBLIC WORKS AND CITY ENGINEER. I'M HERE TO LET YOU KNOW THAT THE CITY OF PICO RIVERA IS VERY MUCH IN FAVOR OF THIS MOTION. WE WANTED TO THANK YOU FOR THE SUPPORT OF THE DURFEE UNDERPASS PROJECT. THE DURFEE RAILROAD CROSSING HAS BEEN A HUGE SAFETY ISSUE IN THE CITY OF PICO RIVERA FOR MANY YEARS. IT'S AN HIGHLY URBAN AREA AND IT'S NEAR MUNICIPAL PARKS, CHURCHES, EVENT HALLS, SCHOOLS. THERE'S A SCHOOL IN VERY CLOSE PROXIMITY, AND THERE'S HUNDREDS OF STUDENTS CROSSING THE RAILROAD TRACKS EVERY DAY. AND BECAUSE OF THE MANY ISSUES OVER THE LAST 20 YEARS, WE'VE HAD FOUR FATALITIES THERE AS WELL AS ONE VEHICLE-TRAIN COLLISION. MOST RECENTLY, THERE WAS A NEAR CATASTROPHE THAT WAS AVOIDED WHEN A LITTLE BOY WAS ASSISTED OFF THE TRACKS AND MOMENTS AFTER A METROLINK PASSED THROUGH AT SPEEDS NEARING 70 MILES PER HOUR. SO DUE TO THESE MANY SAFETY ISSUES, CONGRESSWOMAN LINDA SANCHEZ IS ALSO STRONGLY SUPPORTING THE DURFEE UNDERPASS PROJECT AND IS ENCOURAGING THAT THE ACE BOARD FINANCE IT. AND WITH THAT, I WANT TO THANK YOU FOR YOUR TIME AND AGAIN FOR YOUR SUPPORT OF THE DURFEE UNDERPASS PROJECT. THANK YOU. 

SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU, MR. CERVANTES. WE HAVE THE ITEM BEFORE US. SUPERVISOR MOLINA, DO YOU WANT TO MAKE AN AMENDMENT? 

SUP. MOLINA: I DO. I HAVE A MOTION. AM I ON HERE? 

SUP. YAROSLAVSKY, CHAIRMAN: YES. 

SUP. MOLINA: REGARDING ITEM 3, I'M GOING TO "MOVE THAT OUR COUNTY REPRESENTATIVE IN THE SAN GABRIEL VALLEY COUNCIL OF GOVERNMENTS DIRECT THE COMMENCEMENT OF THE DESIGN AND RIGHT-OF-WAY ACQUISITION FOR THE FAIRWAY DRIVE ALHAMBRA SUBDIVISION GRADE SEPARATION PROJECT." I THINK THAT WILL KEEP THEM MOVING ON THE LIST, RIGHT? SO IF THERE'S NO PROBLEM WITH THAT, I WOULD AMEND IT. 

SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. IS THERE ANY DISCUSSION? NO OBJECTION TO THE AMENDMENT? WE HAVE THE ITEM BEFORE US. MOVED BY KNABE. SECONDED BY MOLINA. WITHOUT OBJECTION, UNANIMOUS VOTE ON ITEM 2. I HAVE A COUPLE OF ADJOURNING MOTIONS FIRST I'D LIKE TO ASK THAT WE ADJOURN IN THE MEMORY OF HE EDEN COOPER SAGE AN EDUCATOR IN JEWISH RELIGIOUS SCHOOLS A SCHOOL ADMINISTRATOR FOR TEMPLE ISRAEL OF HOLLYWOOD WHO PASSED AWAY AFTER A LONG STRUGGLE WITH CANCER. SHE'S SURVIVED BY HER HUSBAND DR. JEFFREY SAGE, TWO SONS ELIJAH AND JONAH, HER PARENTS GERSON AND CAROL COOPER AND MANY FRIENDS, COLLEAGUES AND FORMER STUDENTS. I ASK THAT WE ALSO ADJOURN IN THE MEMORY OF TAMARA BROOKS WHO RECENTLY PASSED AWAY SUDDENLY AT THE AGE OF 70. TAMARA WAS AN ARTIST ALSO BELOVED MENTOR, MOTHER, GRANDMOTHER. SHE'S SURVIVED BY HER HUSBAND, ACTOR, DIRECTOR AND AUTHOR THEODORE BIKEL AND MANY FAMILY MEMBERS AND FRIENDS. ALSO ASK THAT WE ADJOURN IN THE MEMORY OF SIDNEY PRESSBERG LONG- TIME RESIDENT OF OUR DISTRICT AND GOOD FRIEND OF MY OFFICE FOR MANY, MANY YEARS WHO RECENTLY PASSED AWAY AFTER AFTER A LENGTHY ILLNESS. SIDNEY WAS A HOLOCAUST SURVIVOR, FOUNDED PK EQUITIES IN 1960, A SUCCESSFUL FIRM REAL ESTATE MANAGEMENT AND DEVELOPMENT. OVER THE DECADES HIS FIRM HAS BEEN RESPONSIBLE FOR THE DEVELOPMENT OF HUNDREDS OF SINGLE-FAMILY HOMES IN NEVADA AND ELSEWHERE. HE'S BEEN LONG TIME LEADER IN THE JEWISH COMMUNITY AND HE WILL BE DEEPLY MISSED. HE'S SURVIVED BY HIS WIFE ANNA, A SON KEN, THREE GRANDCHILDREN AND OTHER FAMILY MEMBERS. ALSO JUST LEARNED OF THE PASSING OF SHIMON ________, FORMER COLONEL IN THE ISRAELI ARMED FORCES AND RESIDENT OF LOS ANGELES FOR MANY, MANY YEARS AND ONE OF THE FOUNDERS OF THE CHRISTIAN ISRAEL NEXUS. GREAT HUMAN BEING WHO PASSED AWAY ON SUNDAY AFTER A VERY LONG ILLNESS WHICH HE BATTLED VALIANTLY FOR ALL THOSE YEARS. I'LL GET YOU THE INFORMATION, I JUST LEARNED ABOUT IT. WITHOUT OBJECTION, UNANIMOUS VOTE. SUPERVISOR KNABE? 

SUP. KNABE: THANK YOU, MR. CHAIRMAN. NUMBER OF ADJOURNMENTS TODAY. FIRST OF ALL THAT WE ADJOURN IN MEMORY OF A DEAR FRIEND, MR. BOB MAXWELL LEWIS. BOB PASSED AWAY PEACEFULLY ON MAY 23RD. HE WILL BE DEARLY MISSED BY ALL. HE IS SURVIVED BY HIS THREE DAUGHTERS PAT, JEANNE, AND MARSHA. LONG TIME FRIENDS. ALSO ADJOURN IN MEMORY OF LUCY LEE, MOTHER OF JOSEPH LEE, MY CONSUMER AFFAIRS COMMISSIONE, PASSED AWAY ON MAY 17TH. SHE IS SURVIVED BY HER TWO SONS JOSEPH AND JOSHUA. ALSO THAT WE ADJOURN IN MEMORY OF LONG TIME LEGEND SAM DIMAS, LONG BEACH POLY COACHING LEGEND WHO PASSED AWAY AT THE AGE OF 89 ON MAY 23RD. HE GRADUATED FROM POLY AND THEN WENT ON TO LONG BEACH COMMUNITY COLLEGE WHERE HE WAS CAPTAIN OF THE FOOTBALL TEAM FOR TWO YEARS AND WAS STUDENT BODY PRESIDENT. HE SERVED IN THE UNITED STATES ARMY, HE WAS PART OF THE INVASION OF NORMANDY, RECEIVED A BRONZE STAR, A PURPLE HEART, INFANTRY COMBAT BADGE AND OTHER MEDALS. HE RETURNED TO COLLEGE AT U.C. SANTA BARBARA THEN CAME BACK TO LONG BEACH. AFTER 37 YEARS AT POLY, AS A COACH AND TEACHER, HE RETIRED IN 1987. HE WAS A BOOSTER, FUND-RAISER, FAN AND UNOFFICIAL HISTORIAN WHEN IT CAME TO POLY. HE WAS IN THE INAUGURAL POLY FOOTBALL HALL OF FAME, THE LONG BEACH CITY COLLEGE HALL OF CHAMPIONS, AND THE CENTURY CLUB HALL OF FAME. HE WAS VERY ACTIVE MEMBER OF THE DOWNTOWN LION'S CLUB AND THE LONG LONG BEACH ELKS. A KIND HAPPY MAN AND WAS WELL LIKED BY EVERYONE. HE WILL BE SORELY MISSED. HE IS SURVIVED BY HIS FOUR SONS, MICHAEL, NICK, JOHN AND SAM AND EIGHT GRANDCHILDREN. ALSO WE ADJOURN IN MEMORY OF DOLORES TUCKER, WHO PASSED AWAY RECENTLY AT THE AGE OF 85. SHE IS SURVIVED BY HER SON PHIL. ALSO WE ADJOURN IN MEMORY CLARA COOK ANDREWS, THE QUEEN OF VOLUNTEERISM IN LONG BEACH, WHO PASSED AWAY ON MAY 23RD AT THE AGE OF 97. SHE WORKED MORE THAN 60 YEARS WITH MANY, MANY NONPROFIT ORGANIZATIONS. SHE IS EXECUTIVE DIRECTOR OF THE COMMUNITY VOLUNTEER OFFICE, ADMINISTRATED CHILDREN'S DENTAL HEALTH CLINIC ON AND ON AND ON. SHE ENJOYED PLAYING BRIDGE AND WORKING IN THE ASSISTANCE LEAGUE THRIFT SHOP LATER ON. SHE IS SURVIVED BY SON ANDY, DAUGHTER GAYLE, SISTER JO MARY THOMASON, FOUR GRANDCHILDREN AND FIVE GREAT-GRANDCHILDREN. ALSO WE ADJOURN IN MEMORY OF MELVIN BURGER WHO PASSED AWAY AT HIS HOME MAY 10TH AT THE AGE OF 82, HE WAS A VETERAN. AFTER HIS RETIREMENT, HE TRAVELED EXTENSIVELY AFTER RETIRING FROM SOUTHERN CALIFORNIA EDISON, EXCUSE ME, WITH HIS WIFE MARJORIE. HE IS SURVIVED BY HIS WIFE OF 50 YEARS MARJORIE, HIS FOUR CHILDREN, SHARON, SUSAN, LARRY, AND KENNETH, TWO GRANDCHILDREN AND TWO GREAT-GRANDCHILDREN. AND FINALLY LEO ALAN ADAM, LONG TIME RESIDENT OF THE CITY OF LAKEWOOD WHO PASSED AWAY. HE WILL BE GREATLY MISSED FOR HIS KINDHEARTEDNESS AND LOYALTY TO HIS FAMILY. SURVIVED BY HIS WIFE OF 56 YEARS, ELIZABETH, TWO DAUGHTERS, RITA AND KAREN, TWO GRANDCHILDREN, EIGHT SIBLINGS AS WELL AS MANY NIECES, NEPHEWS AND MOST OF ALL FRIENDS. THOSE ARE MY ADJOURNMENTS. 

SUP. YAROSLAVSKY, CHAIRMAN: WITHOUT OBJECTION, SO ORDERED. SUPERVISOR ANTONOVICH? 

SUP. ANTONOVICH: FIRST I HAVE A MOTION FOR NEXT WEEK. "THE MEDIA RECENTLY-- ACTUALLY THIS IS A REPORT BACK-- RECENTLY REPORTED THE ANTELOPE VALLEY RESIDENTS OF ALL ETHNIC BACKGROUNDS FACE HIGHER MORTALITY RATES THAN THE REST OF THE COUNTY OF LOS ANGELES AND THAT THE RATES FOR BLACK AMERICANS RESIDENTS ARE EVEN HIGHER ACCORDING TO THE MOST RECENT HEALTH STATISTIC. SO I MOVE THAT THE BOARD DIRECTOR OF PUBLIC HEALTH WORKING WITH THE DEPARTMENT OF HEALTH SERVICES AND MENTAL HEALTH REPORT BACK IN 30 DAYS WITH THE COMPARATIVE ASSESSMENT OF MORTALITY RATES IN THE HIGH DESERT AND THE REST OF THE COUNTY AS WELL AS ACTIONS BEING TAKEN, AND PLAN TO BE TAKEN TO ADDRESS THE COMMUNITY HEALTHCARE NEEDS. SO THAT'S A REPORT BACK, MR. CHAIRMAN. 

SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. WITHOUT OBJECTION, WE'LL APPROVE IT AS A REPORT BACK. 

SUP. ANTONOVICH: I WOULD LIKE TO MOVE TODAY WE ADJOURN IN MEMORY OF JOANNE SARGEANT, A WONDERFUL LADY, LONGTIME RESIDENT OF THE GLENDALE. SHE WORKED WITH HER HUSBAND IN BUILDING THE JOHN SARGEANT INSURANCE COMPANY IN GLENDALE. SHE SERVED AS THE PRESIDENT OF THE OAKMONT LEAGUE, MEMBER OF THE DAYS OF THE VERDUGOS, THE GLENDALE ROSE PARADE FLOAT COMMITTEE, BOARD MEMBER OF THE GLENDALE ASSOCIATION FOR THE RETARDED. SHE IS SURVIVED BY HER HUSBAND JOHN AND HER THREE CHILDREN. WONDERFUL LADY, QUITE INVOLVED IN ALL ASPECTS OF THE COMMUNITY. FRED SOLDWEDEL, WHO PASSED AWAY ON MAY 14TH, FORMER PRESIDENT AND DIRECTOR OF THE PASADENA TOURNAMENT OF ROSES, AN ATTORNEY WHO SERVED IN THE UNITED STATES NAVY. HE WAS ALSO PAST CHAIRMAN OF THE PASADENA BAR ASSOCIATION, THE CHAMBER OF COMMERCE, NAVY LEAGUE, ROTARY CLUB, SAN GABRIEL VALLEY ESTATE PLANNING COUNCIL, SAN MARINO CITY CLUB AND THE SAN MARINO, SOUTH PASADINO Y.M.C.A. HE WAS A DEACON AND ELDER AND A FOUNDATION TRUSTEE FOR THE SAN MARINO COMMUNITY CHURCH. FRANK ARCIERO, HE PASSED AWAY AT THE AGE OF 86 AFTER COMING FROM ITALY IN 1939. HE SERVED IN THE KOREAN WAR. HE AND HIS BROTHER BUILT ARCIERO BROTHERS WHICH BECAME ONE OF THE LARGEST CONCRETE CONTRACTING BUSINESSES IN THE WORLD WITH COMMERCIAL PROJECTS INCLUDING PARKING STRUCTURES, SEA WALLS AND OFFICE BUILDINGS. HE WAS ALSO INVOLVED IN AUTO RACING, HELPING TO ESTABLISH THE ARCIERO RACING TEAM. HE MOVED TO PASO ROBLES AND BECAME A PROMINENT WINE MAKER AND OWNER OF EOS VINEYARDS. LEO CAMPBELL PASSED AWAY ON APRIL 25TH SERVED DURING THE KOREAN WAR. HE WAS AN INSURANCE MUTUAL FUNDS BROKER AND MANAGED CENTURY 21 LARSON REALTY. HE SERVED AS PRESIDENT OF THE WEST GLENDALE KIWANIS. MARGIE ELOW, FIRST FEMALE PRINCIPAL FOR LINCOLN, NEBRASKA CITY-WIDE SCHOOL SYSTEM. THE AUNT OF RANDY MANTOOTH FROM THE HIT 1970S TELEVISION SHOW "EMERGENCY" WHO ALSO WORKED CLOSELY WITH THE LOS ANGELES COUNTY FIRE DEPARTMENT ON NUMEROUS CAUSES AND EVENTS. OTTO JENSEN PASSED AWAY AT THE AGE OF 81 WHEN HE WAS STRUCK BY A VEHICLE WHILE CROSSING A STREET NEAR HIS PHOTO STUDIO. THE VEHICLE WAS DRIVEN BY A LADY WHO WAS 91. HE WAS A PHOTOGRAPHER IN BURBANK AND WORKED WITH THE HOLLYWOOD STARS AND SPORTS CELEBRITIES FOR MANY YEARS. LUCY LING-HUEI HAN LEE WAS THE FOUNDER OF THE ORIENTAL MEDICAL COLLEGE, THE FIRST CHINESE MEDICAL SCHOOL IN HAWAII. SHE WAS APPOINTED BY THE STATE OF HAWAII AS THE FIRST CHINESE MEDICAL DOCTOR EXAMINATION BOARD CHAIRMAN. BY THE TIME SHE HAD RETIRED AND MOVED TO LOS ANGELES COUNTY, SHE HAD TRAINED MANY HUNDREDS OF DOCTORS. DENNIS JOSEPH WIBLE, VIETNAM VETERAN SERVED IN THE UNITED STATES ARMY, WORKED AT NORTHUP GRUMMAN FOR THE PAST 37 YEARS. RAUL FIGUEROA, PASSED AWAY AT THE AGE OF 65, A RETIRED DEPUTY OF LOS ANGELES COUNTY SHERIFF. HE RETIRED FROM THE HALL OF JUSTICE JAIL. THOSE ARE MY ADJOURNING MOTIONS. 

SUP. YAROSLAVSKY, CHAIRMAN: WITHOUT OBJECTION, UNANIMOUS VOTE. SUPERVISOR MOLINA, ANY ADJOURNING MOTIONS? 

SUP. MOLINA: YES. I'D LIKE TO ASK TODAY THAT WE ADJOURN IN THE MEMORY OF JOHNNY MELLANO, HE'S A SECOND GENERATION OWNER OF MELLANO & COMPANY, ONE OF THE LARGEST AND OLDEST FLOWER COMPANIES IN CALIFORNIA. HE DIED SUNDAY, UNFORTUNATELY. HE WAS 76 YEARS OLD. JOHNNY WAS A FAMILY MAN AND LOVED THE FLOWER BUSINESS AND HE LET NOTHING GET IN THE WAY OF HIS TWO PASSIONS. HE WAS DEDICATED TO MELLANO & COMPANY, SUPPORTED THE FLORAL INDUSTRY AND MADE MANY LIFELONG FRIENDS THROUGHOUT THE INDUSTRY. JOHNNY REGULARLY CAME TO MELLANO & COMPANY'S LOCATION AT THE LOS ANGELES FLOWER MARKET IN THE EARLY MORNINGS. HE HAD 50 PLUS YEARS AND HE REMAINED ACTIVE IN THE L.A. FLOWER MARKET BOARD OF DIRECTORS. HE'S SURVIVED BY HIS MOTHER MARIA, HIS WIFE DIANE, SON MIKE, DAUGHTER-IN-LAW VAL, SON JIM, DAUGHTER-IN-LAW MONICA, SON BOB AND DAUGHTER-IN-LAW MARY, DAUGHTER LINDA AND SON-IN-LAW ERNIE SANTOS, SON STEVE AND DAUGHTER-IN-LAW MANDANA AND 13 GRANDCHILDREN. HE IS ALSO REMEMBERED BY HIS BROTHER MIKE SENIOR AND HIS WIFE, SISTER ROSE MARIE AND HUSBAND. MANY NIECES NEPHEWS AND OVER 200 MEMBERS OF THE MELLANO COMPANY. 

SUP. YAROSLAVSKY, CHAIRMAN: WITHOUT OBJECTION, UNANIMOUS VOTE. SUPERVISOR RIDLEY-THOMAS? 

SUP. RIDLEY-THOMAS: MR. CHAIRMAN, PLEASE JOIN ME IN ADJOURNING IN MEMORY OF THE REVEREND HAMEL HARTFORD BROOKINS. COMMONLY KNOWN AS BISHOP H.H. BROOKINS WHO WAS BORN ON JUNE THE EIGHTH, 1925 IN YAZOO, MISSISSIPPI. HE PASSED AWAY ON MAY THE 22ND OF THIS YEAR AT THE AGE OF 86. HE ATTENDED CAMPBELL COLLEGE IN JACKSON, MISSISSIPPI AND LATER GRADUATED WITH A BACHELOR OF ARTS DEGREE FROM WILBERFORCE UNIVERSITY AND A DIVINITY DEGREE FROM PAYNE THEOLOGICAL SEMINARY. HE BEGAN HIS CAREER IN WICHITA, KANSAS AND RELOCATED TO LOS ANGELES IN 1965 WHEN HE WAS TRANSFERRED TO THE FIRST A.M.E. CHURCH. HE WAS A LEADER IN THE CIVIL RIGHTS MOVEMENT IN LOS ANGELES AND BECAME THE FIRST PRESIDENT OF THE UNITED STATES CIVIL RIGHTS COUNCIL. MARCHED WITH MARTIN LUTHER KING, JR. AND ADVISED POLITICAL FIGURES SUCH AS LOS ANGELES SUPERVISOR KENNETH HAHN, GOVERNOR JERRY BROWN, PRESIDENTS JOHN F. KENNEDY, JIMMY CARTER AND BILL CLINTON. MR. CHAIRMAN AND COLLEAGUES, HE WILL BE REMEMBERED AS AN INTERNATIONAL CHAMPION FOR POLITICAL EQUALITY. HE IS SURVIVED BY HIS WIFE, REVEREND ROSALYNN BROOKINS, HIS CHILDREN STEVEN, FRANCINE AND SIR-WELLINGTON. AND A HOST OF EXTENDED FAMILY AND FRIENDS IN THE ENTIRE ECUMENICAL COMMUNITY WHO KNEW HIM, RESPECTED HIM LEARNED TO FOLLOW HIS LEAD. THE REVEREND H.H. BROOKINS. 

SUP. YAROSLAVSKY, CHAIRMAN: ALL MEMBERS ON THAT. 

SUP. RIDLEY-THOMAS: THANK YOU, MR. CHAIRMAN. AND THEN ELOISE TERRRIANN PORTER, BORN THE EIGHTH OF MARCH, 1930 IN SPARTANBURG, SOUTH CAROLINA. SHE PASSED ON MAY THE 18TH OF THIS YEAR AT THE AGE OF 82. SHE MOVED TO MICHIGAN WITH HER MOTHER IN 1938 AND EARNED A BACHELOR OF ARTS AND A MASTER'S DEGREES IN PLANNING FROM THE UNIVERSITY OF DETROIT. SHE SERVED THE CITY OF DETROIT FOR SOME 32 YEARS, FIRST WORKING AS A SOCIAL WORKER AND EVENTUALLY AS A PRINCIPAL PLANNER. 1988 SHE RETIRED AND MOVED TO WHEATLEY, ONTARIO CANADA AND SUBSEQUENTLY RELOCATED TO LAS VEGAS, NEVADA. SHE ENJOYED DANCING, FASHION AND TRAVELING AND WILL BE REMEMBERED FOR HER WARM PERSONALITY AND DEDICATION TO HELPING PEOPLE ACHIEVE THEIR GOALS. SHE IS SURVIVED BY HER HUSBAND HOWARD, HER SONS DERRICK AND DERMOT, THREE GRANDSONS, TWO GREAT GRANDSONS AND A HOST OF FAMILY AND FRIENDS WHO WILL MISS HER DEARLY. ELOISE TERRIANN PORTER. FINALLY, FRANK HOLOMAN, BORN JANUARY 10, 1934 IN KANSAS CITY MISSOURI AND PASSED ON MAY 24 OF THIS YEAR AT THE AGE OF 78. HE RELOCATED TO LOS ANGELES IN 1959 AND BECAME THE OWNER OF TWO OF SOUTH LOS ANGELES' MOST POPULAR FOOD EATERIES KNOWN AS THE BOULEVARD CAFE AND, SECONDLY, FRANK'S PLACE. THE MID-'60S HE SERVED AS A PART-TIME ADMINISTRATIVE ASSISTANT TO THEN CALIFORNIA STATE ASSEMBLYMAN JESSE UNRUH AND SPENT FIVE YEARS WITH HIM AS A FULL-TIME STAFFER. MR. HOLOMAN ENTERED THE CALIFORNIA STATE ASSEMBLY IN 1972 AND WAS IMMEDIATELY ELECTED CHAIRMAN OF HIS FRESHMAN CLASS. HE WAS A LONG-TIME MEMBER OF THE BLACK BUSINESS ASSOCIATION AND HOSTED MANY OF THEIR MEETINGS IN THE '90S AND EARLY 2000S. HE WILL BE REMEMBERED FOR HIS WELCOMING AND WARM SPIRIT, PROVIDING A PLACE TO CATCH UP ON ALL THE HAPPENINGS IN SOUTH LOS ANGELES. HE IS SURVIVED BY A HOST OF FAMILY AND FRIENDS WHO WILL MISS HIM DEARLY, FRANK HOLOMAN, MR. CHAIRMAN. THAT CONCLUDES MY ADJOURNING MOTIONS. 

SUP. YAROSLAVSKY, CHAIRMAN: NO OBJECTION, UNANIMOUS VOTE. 

SUP. KNABE: ALL MEMBERS. 

SUP. YAROSLAVSKY, CHAIRMAN: YES, ALL MEMBERS, ALL RIGHT. WHAT ELSE DO WE HAVE? 

CLERK SACHI HAMAI: MR. CHAIRMAN, WE HAVE ITEM NUMBER 46, I HELD THAT BECAUSE WE DIDN'T HAVE FOUR VOTES AT THE TIME BUT IF WE COULD TAKE THAT ITEM IT'S BEFORE YOU. 

SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. ITEM 46 IS BEFORE US? 

CLERK SACHI HAMAI: YES. 

SUP. YAROSLAVSKY, CHAIRMAN: IT'S MOVED BY KNABE. SECONDED BY RIDLEY-THOMAS. WITHOUT OBJECTION, UNANIMOUS VOTE. 

CLERK SACHI HAMAI: THANK YOU. THEN WE HAVE EITHER THE DISCUSSION ITEM, ITEM NUMBER 78 OR ITEM NUMBER 79, WHICH IS THE PUBLIC HEARING. 

SUP. YAROSLAVSKY, CHAIRMAN: IS THERE ANYBODY WHO WISHED TO BE HEARD ON 79? 

CLERK SACHI HAMAI: YES. 

SUP. YAROSLAVSKY, CHAIRMAN: GO AHEAD. 

CLERK SACHI HAMAI: SO ALL THOSE WHO PLAN TO TESTIFY BEFORE THE BOARD PLEASE STAND AND RAISE YOUR RIGHT HAND TO BE SWORN IN. AND I BELIEVE THERE'S ONLY ONE PERSON. IN THE TESTIMONY YOU MAY GIVE BEFORE THIS BOARD, DO YOU SOLEMNLY AFFIRM TO TELL THE TRUTH, THE WHOLE TRUTH AND NOTHING BUT THE TRUTH SO HELP YOU GOD? THANK YOU. YOU MAY BE SEATED. THIS ITEM IS BEFORE YOU. 

SUP. YAROSLAVSKY, CHAIRMAN: I ONLY HAVE ONE PERSON WHO'S ASKED TO BE HEARD. ARNOLD SACHS. MR. SACHS, WERE YOU SWORN IN? I DIDN'T SEE YOU STANDING. 

ARNOLD SACHS: GOOD AFTERNOON, ARNOLD SACHS. THE FACT THAT YOU'RE WILLING TO UPHOLD THE CALIFORNIA VEHICLE CODE, THE VEHICLE CODE PUT IN PLACE BY THE STATE OF CALIFORNIA YET CERTAIN PROVISIONS OF STATE LAWS YOU ARE UNWILLING TO UPHOLD EVEN THOUGH YOU'RE SWORN WHEN YOU TAKE OFFICE TO UPHOLD THE CALIFORNIA CONSTITUTION. SO MY QUESTION WOULD BE WHY WOULD YOU HAVE PEOPLE WHO WANT TO TESTIFY BEFORE YOU SWEAR TO TELL THE TRUTH WHEN YOU YOURSELVES, SWORN TO UPHOLD AN OATH, BUT YOU DON'T UPHOLD THE OATH THAT YOU'RE SWORN TO TAKE? JUST DOESN'T MAKE SENSE WHY YOU HAVE DOUBLE STANDARDS FOR THE PUBLIC ON THIS SIDE OF THE MICROPHONE. AND WHAT WAS IT? YOU HAD STANDARDS FOR UNSCRUPULOUS DEVELOPERS. WHAT KIND OF POLICIES DO WE HAVE FOR UNSCRUPULOUS POLITICIANS? BUT BACK TO MY POINT HERE. 

SUP. YAROSLAVSKY, CHAIRMAN: STICK TO ITEM, MR. SACHS. 

ARNOLD SACHS: BACK TO MY POINT HERE, THE VEHICLE CODE IS THE CODE OF STATE OF CALIFORNIA, THE SAME STATE LAWS THAT YOU'RE SWORN TO UPHOLD. 

SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. THE ITEM IS BEFORE US. ITEM 79 IS MOVED BY ANTONOVICH. SECONDED BY MOLINA. WITHOUT OBJECTION, UNANIMOUS VOTE. ITEM 78, THE DISCUSSION ITEM. WHO'S COMING ON THIS? DO YOU HAVE ANY STAFF ON THIS, COUNTY COUNSEL? MR. KRATTLI ARE YOU GOING TO PRESENT THIS ITEM? 

JOHN KRATTLI, COUNSEL: YES, I CAN. 

SUP. YAROSLAVSKY, CHAIRMAN: OKAY. WHY DON'T YOU DO THAT? 

JOHN KRATTLI, COUNSEL: MEMBERS OF THE BOARD. THIS ITEM RELATES TO ACTION REQUIRED BY YOUR BOARD TO APPOINT AN INTERIM ASSESSOR SHOULD A VACANCY OCCUR. BOTH THE CALIFORNIA CONSTITUTION AND THE COUNTY CHARTER REQUIRE THAT THE POSITION OF ASSESSOR BE ELECTED. STATE LAW PROVIDES FOR VARIOUS WAYS IN WHICH THAT OFFICE MAY BECOME VACANT PRIOR TO THE EXPIRATION OF THE TERM INCLUDING RESIGNATION FROM THE OFFICE, RECALL, AND ALSO A CONVICTION OF A FELONY OR AN OFFENSE INVOLVING VIOLATION OF OFFICIAL DUTIES. IF THE OFFICE OF ASSESSOR WAS TO BECOME VACANT, THE CHARTER REQUIRES THAT YOUR BOARD APPOINT A REPLACEMENT WHO WILL REMAIN IN OFFICE UNTIL A SUCCESSOR IS ELECTED AT THE NEXT GENERAL ELECTION. JUST EXACTLY WHEN THAT ELECTION WILL BE IS ENTIRELY DEPENDENT ON WHEN THE VACANCY OCCURS. THE STANDARD DEADLINE FOR ORDERING ELECTION IS 88 DAYS IN ADVANCE OF THE DATES SPECIFIED IN THE ELECTIONS CODE. THE DEADLINE FOR THE NOVEMBER 6, 2012 ELECTION IS AUGUST 10TH. IF A VACANCY IN THE OFFICE OF ASSESSOR EXISTS PRIOR TO THAT DATE, THEN THE SUCCESSOR WOULD BE ELECTED AT THE NOVEMBER 6, 2012 ELECTION. IF THE VACANCY DOES NOT OCCUR UNTIL AFTER AUGUST 10TH, THEN THE INTERIM ASSESSOR THAT YOUR BOARD WOULD APPOINT TO FILL THE VACANCY WOULD SERVE UNTIL A SUCCESSOR IS ELECTED AND SWORN IN FOLLOWING THE GENERAL ELECTION IN 2014. AND THAT CONCLUDES MY REPORT. 

SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. ARE THERE ANY QUESTIONS? SEEING NONE, THANK YOU FOR THE REPORT. DO WE HAVE PUBLIC COMMENT? JOHN, IT'S ESSENTIALLY THE SAME PROCESS THAT WE WOULD HAVE GONE THROUGH. MR. KRATTLI? ESSENTIALLY THE SAME PROCESS WE WOULD HAVE GONE THROUGH IF THERE WOULD HAVE BEEN A VACANCY CREATED IN THE DISTRICT ATTORNEY'S OFFICE IN THE LAST ELECTION? 

JOHN KRATTLI, COUNSEL: YES. 

SUP. YAROSLAVSKY, CHAIRMAN: IS IT IDENTICAL? 

JOHN KRATTLI, COUNSEL: IT IS THE SAME PROCESS, YES. 

SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. I HAVE A NUMBER OF PEOPLE WHO WISH TO BE HEARD ON PUBLIC COMMENT. JORGE FINIZO? IS HE HERE? MICHAEL TURNER? MARTHA FRANCO? AND GEORGE FENIZO? 

GEORGE FINIZO: GOOD AFTERNOON, SUPERVISORS. MY NAME IS GEORGE FINIZO, AND I'M AN L.A. COUNTY I.H.S.S. CAREGIVER. AT THE RISK OF SOUNDING LIKE A GAME SHOW HOST, I'D LIKE TO START BY ASKING YOU A QUESTION. WHO WANTS TO BE A HERO TODAY? THIS MAY SEEM LIKE A SILLY QUESTION, BUT I CAN ASSURE YOU THAT IT'S TOTALLY SERIOUS. ALTHOUGH I HAVE BEEN AN L.A. COUNTY I.H.S.S. CAREGIVER FOR FIVE YEARS, I'VE ACTUALLY BEEN PROVIDING CARE TO MY CLIENT FOR NEARLY 20 YEARS. DURING THAT TIME, I'VE TAKEN MY CLIENT TO MORE DOCTOR VISITS, TESTS, MEDICAL TREATMENTS, AND OPERATIONS THAN EITHER OF US CARE TO REMEMBER, INCLUDING SEVERAL VISITS TO BOTH CEDARS-SINAI AND U.C.L.A. IN FACT, HER CONDITION IS SO CHALLENGING THAT BEFORE SHE MET HER CURRENT DOCTOR, SHE WAS IMMEDIATELY DECLINED BY THREE BLUE CROSS H.M.O. DOCTORS BASED ON HER AILMENTS AND POTENTIALLY FATAL CONDITION. THERE WAS EVEN A PERIOD OF TIME FOR ABOUT TWO TO THREE YEARS WHERE WE WERE IN THE ER ROOM FOR APPROXIMATELY ONCE A MONTH. AS HER DOCTOR POINTED OUT MANY MONTHS AGO, EACH ER ROOM VISIT COSTS THE COUNTY THOUSANDS OF DOLLARS; HOWEVER, I'M PLEASED TO SAY WE RECENTLY PASSED THE THREE YEAR AND THREE MONTH MARK SINCE SHE'S BEEN ADMITTED TO THE ER. I KNOW THE WORK I DO HAS MADE A SIGNIFICANT DIFFERENCE AND CONTINUES TO MAKE A DIFFERENCE IN THE QUALITY OF HER LIFE. HER DOCTOR ONCE MENTIONED HER ONLY ALTERNATIVE TO THE CARE I'M PROVIDING WOULD BE A CONVALESCENT HOME. AND WHEN I ASKED HIM HOW MANY CONVALESCENT HOMES WOULD PROVIDE THE SERVICES I'M PROVIDING FOR HER, HIS ANSWER WAS NONE. I LOVE THE WORK I DO BUT MAKING ENDS MEET ON NINE DOLLARS AN HOUR CAN BE INCREDIBLY STRESSFUL AND I KNOW I'M NOT ALONE SINCE THERE ARE APPROXIMATELY 128,000 CAREGIVERS PROVIDING VITAL HOME CARE SERVICES TO 155,000 L.A. CARE SENIORS AND PEOPLE WITH DISABILITIES. AND WITH THE BABY BOOM GENERATION GETTING OLDER, THE NEED FOR COST-EFFECTIVE HOME CARE WILL ONLY GROW. BUT FINDING WORKERS TO DO THIS WORK ON OUR WAGES WILL BE DIFFICULT, BEING THAT WE BARELY RECEIVE ABOVE MINIMUM WAGE, WHICH BASICALLY LEAVES US IN THE POVERTY CATEGORY. 

SUP. YAROSLAVSKY, CHAIRMAN: OKAY, THANK YOU MR. FINIZIO. MICHAEL TUNRER? 

MICHAEL TURNER: YES, GOOD AFTERNOON. MY NAME IS MICHAEL TURNER AND I'M WITH THE PROGRAM WELFARE-TO-WORK. AND I'VE BEEN IN THE PROGRAM SINCE 2007. THERE'S BEEN MANY PROBLEMS GOING ON WITH THIS PROGRAM. I'VE BEEN IN CONTACT WITH MARK RIDLEY-THOMAS' OFFICE SEVERAL TIMES. I SPOKE WITH MARK ONCE WITH A PROBLEM. AND BECAUSE I SPOKE WITH HIM, THE PROBLEM WAS RESOLVED. HOWEVER, SINCE THEN, THE COUNTY SEEMED LIKE THEY RETALIATED AGAINST ME. I PUT IN COMPLAINTS. I GO THROUGH THE CHAIN OF COMMAND. AND ONCE I CAN'T GET IT RESOLVED THERE, I GO TO THE BOARD OF SUPERVISORS. I'M SORRY, MR. THOMAS' OFFICE, AND THEN I'M RETALIATED AGAINST. I WOULD LIKE THE BOARD TO LOOK INTO DIFFERENT ISSUES THAT'S GOING ON WITH THIS PROGRAM. PARTICIPANTS THAT ARE WITH THIS PROGRAM ARE NOT BEING SERVED THROUGH THIS PROGRAM. AND THERE'S A GREAT CONCERN. MS. GLORIA MOLINA, I WOULD LIKE TO SAY THAT I HAVE A FRIEND OF MINE WHO IS IN YOUR DISTRICT, AND SHE WOULD LIKE TO LET YOU KNOW THAT YOU'RE DOING A GREAT JOB IN THE DISTRICT THAT YOU SERVE. WITH THAT, I WANT TO THANK YOU. 

SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. MARTHA FRANCO, BEFORE YOU START LET ME CALL UP THREE PEOPLE. GEOFFREY HOFFMAN. IS MR. HOFFMAN HERE? CHRIS THORNBERG? AND VIOLET RUIZ? MARTHA FRANCO, THANK YOU. 

MARTHA FRANCO: GOOD AFTERNOON, SUPERVISOR. MY NAME IS MARTHA FRANCO. I'VE BEEN AN L.A. COUNTY HOME CARE PROVIDER FOR SEVEN YEARS. I'M HERE TODAY TO ECHO WHAT MY COWORKERS HAVE BEEN SAYING OVER THE PAST FEW WEEKS DURING THIS MEETING AND TO PUT YET ANOTHER FACE TO MY FACE ON THIS IMPORTANT ISSUE. BECOMING A HOME CARE PROVIDER ISN'T EASY. WHEN I TELL PEOPLE WHAT I DO FOR A LIVING, THEY LOOK AT ME WITH AMAZEMENT AND THEY USUALLY ASK: HOW DO YOU DO IT? I OFTEN WONDER WHAT, TOO. BUT EVERY MORNING I GET UP AND HELP THOSE IN NEED AND DO 128,000 OTHER HOME CARE WORKERS OF L.A. COUNTY. I CAN THINK OF ANOTHER KIND OF JOB THAT GIVES THE SAME SATISFACTION AS BEING A CAREGIVER. EVERY DAY WE KNOW THAT WE'RE MAKING A DIFFERENCE IN PEOPLE'S LIVES. YOU CAN SEE THE GRATITUDE IN THE EYES OF THOSE WE CARE FOR. TO OUR CLIENTS, WE ARE A LIFELINE THAT ALLOWS THEM TO LIVE HOME WHERE THEY WANT TO BE, WHERE THEY DESERVE TO BE. AND THAT'S AN INCREDIBLE FEELING. AND WHILE WE CAN ALL SHARE STORIES ABOUT THE WORK TO DOING THIS WORK, WE CAN ALSO SHARE STORIES ABOUT THE STRUGGLES AND SACRIFICE THAT WE IN OUR FAMILIES MAKE TO BE ABLE TO DO THIS WORK ON OUR CURRENT WAGE. AS REPORT SHOWS FOR MOST OF US, WE LIVE AT OR BELOW THE POVERTY LEVEL. WE ARE FORCED TO MAKE CHOICES BETWEEN WHAT BILLS TO PAY AND WHAT BILLS TO PUSH FOR ANOTHER MONTH, WHAT PHONE CALLS TO ANSWER AND WHAT WE WANT TO AVOID BECAUSE YOU KNOW IT'S A BILL COLLECTOR. AND UNLIKE OTHER WORKERS, WE DON'T GET VACATION TIME TO SPEND WITH OUR FAMILIES OR SICK LEAVE WHEN WE ARE ILL. SO WHEN PEOPLE ASK ME "HOW DO YOU DO IT?" I SOMETIMES SAY "I DON'T KNOW." I CAN'T TELL YOU THAT BY BEGINNING ABLE TO MAKE THE COUNTY LIVING WAGE FOR 9.65 AN HOUR WILL DEFINITELY HELP. 

SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU MS. RUIZ. YOUR TIME IS UP. BUT IF YOU'D LIKE TO LEAVE THE TESTIMONY, WE CAN INCORPORATE IT AS PART OF THE RECORD. GEOFFREY HOFFMAN? 

GEOFFREY HOFFMAN: GOOD AFTERNOON. HI, MY NAME IS GEOFFREY HOFFMAN AND I'M A RESEARCHER WITH THE U.C.L.A. CENTER FOR HEALTH POLICY RESEARCH. I WAS THE LEAD AUTHOR OF A REPORT PUT OUT BY THE CENTER PUT OUT ENTITLED "HIDDEN IN PLAIN SIGHT: CALIFORNIA'S PAID MEDI-CAL CAREGIVERS ARE VULNERABLE". IN THE REPORT WE DISCUSSED THE PRECARIOUS FINANCIAL SITUATION OF CALIFORNIA'S IN-HOME SUPPORTIVE SERVICES WORKERS. I.H.S.S. AS IS THE PROGRAM IT'S KNOWN IS A JOINTLY FUNDED STATE AND LOCAL PROGRAM WHICH REIMBURSES FAMILY MEMBERS, FRIENDS AND OTHER CAREGIVERS WHO CARE FOR LOW-INCOME OLDER ADULTS. WE HAD THREE MAJOR FINDINGS. FIRST WE FOUND BY ANY ECONOMIC MEASURES, THESE CAREGIVERS ARE ECONOMICALLY INSECURE COMPARED TO OTHER CALIFORNIANS, THESE CAREGIVERS HAD MUCH HIGHER RATES OF POVERTY. ABOUT 60 PERCENT OF THEM HAD INCOMES THAT WERE EITHER BELOW THE POVERTY LEVEL OR AT NEAR POVERTY. THE AVERAGE MONTHLY INCOME FOR THESE CAREGIVERS IS ONLY HALF THAT OF ADULT NONCAREGIVERS, ABOUT $2,000 FOR PAID CAREGIVERS COMPARED TO OVER $4,000 FOR ADULT NON-CAREGIVERS. BECAUSE OF THESE LOW INCOMES, NEARLY 1/3 OF LOWER INCOME CAREGIVERS EXPERIENCE WHAT'S CALLED FOOD INSECURITY OR DIFFICULTY PURCHASING NEEDED FOOD SUPPLIES EACH MONTH. OUR SECOND FINDING WAS THAT THESE I.H.S.S. WORKERS HAD UNSTABLE WORK SITUATIONS. THEY WERE THE MOST LIKELY OF ALL GROUPS IN CALIFORNIA TO BE AT THEIR JOB FOR A SHORT PERIOD OF TIME, SUGGESTING A HIGH CLIENT TURNOVER. THESE PAID MEDI-CAL CAREGIVERS WERE MORE LIKELY TO BE AT THEIR CURRENT JOBS FOR LESS THAN ONE YEAR AND SIGNIFICANTLY LESS LIKELY TO BE AT THEIR JOBS FOR TEN YEARS OR MORE. AND BECAUSE HEALTH INSURANCE IS LINKED TO EMPLOYMENT, THEIR JOB INSTABILITY WAS COMPOUNDED BY POOR ACCESS TO HEALTHCARE. THESE CAREGIVERS ARE ALMOST TWICE AS LIKELY TO NOT HAVE HEALTH INSURANCE AS NON-CARE GIVING ADULTS WITH ABOUT ONE-THIRD OF THEM UNINSURED. FINALLY THESE CAREGIVERS WERE AT RISK DUE TO CONTINUING CUTS TO STATE AND LOCAL PROGRAMS SUCH AS THE REDUCTIONS IN THE NUMBER OF CLIENT HOURS IN THE I.H.S.S. PROGRAM. REDUCTIONS TO THIS AND OTHER PROGRAMS SUPPORTING SENIORS WILL LIKELY ADD TO THE ECONOMIC BURDENS ALREADY FACED BY THESE CAREGIVERS. 

SUP. YAROSLAVSKY, CHAIRMAN: YOUR TIME IS UP. THANK YOU. CHRIS THORNBERG? 

CHRIS THORNBERG: HI, I'M A FOUNDING PARTNER OF BEACON ECONOMICS, A LOCAL ECONOMIC CONSULTING FIRM. WE DO A VARIETY OF WORK WITH STATE AND LOCAL AGENCIES AS WELL AS PRIVATE SECTOR. WE WERE ASKED TO DO AN ECONOMIC IMPACT ANALYSIS ON THE INCREASE OF WAGES OF THESE WORKERS FROM 9 DOLLARS TO 9.65 AN HOUR. NOW, TYPICALLY IF I DID THE ECONOMIC IMPACT STUDY OF AN INCREASE OF PUBLIC SPENDING, I WOULD COME UP WITH A NET RESULT OF ZERO SINCE YOU'RE REALLY JUST TRANSFERRING RESOURCES AROUND THE ECONOMY. BUT OF COURSE THIS DOESN'T APPLY IN THIS PARTICULAR CASE BECAUSE MUCH OF THE FUNDING FOR THESE WORKERS AS WELL AS THEIR PAY INCREASE WOULD ACTUALLY BE COMING FROM FEDERAL AND STATE SOURCES. IN FACT, ONCE YOU SIT DOWN AND GO THROUGH ALL THE ACCOUNTING, EVEN ACCOUNTING FOR THE FACT THAT OF COURSE THE COUNTY OF LOS ANGELES IS A SIGNIFICANT CONTRIBUTOR TO STATE COFFERS, YOU STILL END UP WITH A SITUATION WHERE ONLY 20 TO 25 PERCENT OF DIRECT FUNDING FOR THIS PAY INCREASE WOULD ACTUALLY COME FROM LOCAL TAXPAYERS. WHAT THAT MEANS WHEN YOU SIT DOWN AND DO THE ECONOMIC IMPACT STUDY, YOU'LL FIND THAT THIS INCREASE IN WAGES WILL COST THE COUNTY ROUGHLY 115 MILLION DOLLARS OF WHICH ALMOST 100 MILLION OF THAT WILL TRANSLATE INTO IMMEDIATE SPENDING. IF WE TAKE AWAY THE 30 MILLION DOLLARS IN SUPPORT FROM LOCAL TAXPAYERS, YOU STILL END UP WITH NET SPENDING OF A LITTLE BIT OVER 60 MILLION DOLLARS. CONTINUE TO GO DOWN THE LIST IF YOU TAKE THAT 60 MILLION DOLLARS, RUN THE TYPICAL IMPACT STUDY, WHAT YOU'LL FIND OUT IS THAT DIRECT SPENDING WILL IN TURN CREATE ANOTHER 30 MILLION DOLLARS IN SECONDARY ECONOMIC IMPACT. SO WHEN YOU ADD IT UP, WHAT WE END UP WITH IS ABOUT 90 MILLION DOLLARS IN ECONOMIC IMPACT FOR A COST TO THE COUNTY, A DIRECT COST TO THE COUNTY OF AROUND 30 MILLION DOLLARS. THIS, PLUS YOU ADD ABOUT 700 JOBS TO THE OVERALL EMPLOYMENT BASE, WHAT YOU HAVE HERE OF COURSE IS NOT ONLY HELPING THESE WORKERS INCREASE THEIR STANDARD OF LIVING BUT ON A THREE TO ONE BASIS THIS IS A NET WIN FOR THE COUNTY OVERALL. AND THE ECONOMIC IMPACT IS STRONGLY POSITIVE. AND AS SUCH, WE WOULD STRONGLY RECOMMEND GOING AHEAD WITH THIS PARTICULAR PAY INCREASE. 

SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. LET ME CALL DOWN ADRIAN VASQUEZ, MIKI JACKSON, PRIMITIVO CASTRO, VIOLET RUIZ. 

VIOLET RUIZ: HELLO MY NAME IS VIOLET RUIZ AND I'M A FIELD REPRESENTATIVE FOR ASSEMBLY MEMBER MIKE ENG FROM THE 49TH DISTRICT, GOOD AFTERNOON. I WILL READ A LETTER FROM THE ASSEMBLY MEMBER. "I AM WRITING TO YOU REGARDING THE ISSUE OF THE COMMUNITY FIRST CHOICE OPTION. THIS IS A PROGRAM CREATED UNDER THE AFFORDABLE CARE ACT IN 2011 THAT WILL PROVIDE AN ADDITIONAL SIX PERCENT IN FEDERAL MEDICAL ASSISTANCE PERCENTAGE FOR THE PROVISION OF MEDICAL ASSISTANCE FOR THE HOME AND COMMUNITY BASE ATTENDANT SERVICES AND SUPPORTS FOR ELIGIBLE MEDI-CAL BENEFICIARIES. IT IS IMPORTANT FOR THE COUNTY OF LOS ANGELES TO PROPERLY USE THE FUNDS FROM THE C.F.C.O. AS THEY WERE INTENDED: TO INCREASE AND IMPROVE ACCESS TO HOME AND COMMUNITY-BASED SERVICES. IT IS CRUCIAL THAT THE INTENT OF THIS PROGRAM, WHICH IS WRITTEN IN THE SOCIAL SECURITY ACT, BE PRESERVED IN LOS ANGELES COUNTY WHEN THE PROGRAM IS IMPLEMENTED AND THAT THE SAVINGS FROM THE C.F.C.O. ARE NOT DIVERTED TO OTHER PURPOSES. THE C.F.C.O. PRESENTS AN OPPORTUNITY TO STABILIZE FUNDING FOR THESE LOS ANGELES COUNTY HOME AND COMMUNITY-BASED PROGRAMS WHICH ARE SO GREATLY RELIED UPON BY THE SENIORS AND PERSONS WITH DISABILITIES POPULATIONS FOR PROVIDING A WAY TO SAFELY REMAIN IN THEIR HOME AND CONTINUE TO LIVE INDEPENDENTLY IN THEIR COMMUNITIES. INVESTMENT IN THESE COMMUNITY PROGRAMS ALSO HELPS SHIFT MEDI-CAL FUNDING AWAY FROM THE BIAS OF INSTITUTIONAL CARE SETTINGS, WHICH ARE CONSTANTLY AND NOT TYPICALLY PREFERRED BY CONSUMERS. THEREFORE I URGE THE LOS ANGELES COUNTY BOARD OF SUPERVISORS TO CAREFULLY CONSIDER HOW THE SAVINGS RESULTING FROM THE C.F.C.O. WILL BE UTILIZED AND TO REFRAIN FROM DIVERTING THOSE SAVINGS TO OTHER PURPOSES WHICH WOULD VIOLATE THE INTENT OF THE LAW. SINCERELY, MIKE ENG." AND I ALSO HAVE A COPY FOR THE COUNTY BOARD OF SUPERVISORS AND C.E.O. WILLIAM FUJIOKA. THANK YOU. 

SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. ADRIAN VASQUEZ. IS ADRIAN VAZQUEZ HERE? IS HAROLD FULLER HERE? HAROLD FULLER? OKAY. COME ON DOWN. MIKI JACKSON? 

MIKI JACKSON: SHALL I START? HI, MIKI JACKSON WITH AIDS HEALTHCARE FOUNDATION, GOOD DAY. I'M HERE TO TALK ABOUT THE ENORMOUS CHANGES THAT ARE COMING TO THE COUNTY HEALTH SYSTEM. AND IN PARTICULAR I'M FOCUSING ON HIV CARE BECAUSE THAT IS WHAT WE DO. WE NEED TO KEEP IN MIND IN ANY IMPLEMENTATION THAT WE'RE DEALING WITH A VERY SENSITIVE CLIENT BASE. ADHERENCE TO A CONTINUUM OF CARE IS OF TREMENDOUS IMPORTANCE. THE IMPLEMENTATION OF ______ AND THE MIGRATION OF CLIENTS TO _________ WILL BE A HUGE UPHEAVAL. AND A.H.F. HAS RECENTLY GOTTEN OUR AWARD AND WE WERE CUT BEHALF IN OUR OUTPATIENT, WHICH MAKES NO SENSE BECAUSE HALF OF THE CLIENTS WILL NOT JUST SUDDENLY PICK UP AND GO TO ________. IT'LL BE A SLOW TRANSITION. WE HAVE NO COMPREHENSION OF WHY THIS WAS DONE. IT JUST SEEMS VERY STRANGE. AND IF YOU ADD THE ADDITION THAT IS BEING PROPOSED OF FEE FOR SERVICE, NOW WE'VE BEEN FEE FOR SERVICE FOR A LONG TIME, BUT IT'S BEEN PUT OFF FOR YEARS, TO PUT IT IN AT THE SAME MOMENT AS A TRANSITION TO _______ IS TO CREATE THE POSSIBILITY OF PROBLEMS IN OVERBURDENING FOR THE COUNTY, THE PROVIDERS AND THE CLIENTS IN A GENTLEMEN OH METRIC FASHION THAT I JUST THINK IS OUT OF CONTROL. WE ALSO THINK THAT ________ WILL NOT COVER EVERYTHING THAT THE HIV CLIENTS NEED. AND WE'RE LOOKING AT SYSTEMS OF KIND OF DOING SUPPLEMENTAL SERVICES AROUND THAT. THERE ARE RYAN WHITE FUNDS FOR SOME OF THAT, AND THAT WOULD BE A RELIEF NOT ONLY TO THE CLIENTS BUT IT COULD HELP THE COUNTY IN NOT HAVING ABSOLUTELY EVERYTHING THAT'S NOT COVERED UNDER ____________ FALL BACK ON THE COUNTY. SO IT'S A TIME WE ALL NEED TO WORK TOGETHER VERY CLOSELY TO MAINTAIN A CONTINUITY OF CARE THAT OUR CLIENTS NEED SO MUCH. 

SUP. YAROSLAVSKY, CHAIRMAN: PRIMITIVE CASTRO? 

PRIMITIVE CASTRO: GOOD AFTERNOON. MY NAME IS PRIMITIVO CASTRO, SENIOR FIELD REPRESENTATIVE WITH ASSEMBLY MEMBER ROGER HERNANDEZ FOR THE 57TH ASSEMBLY DISTRICT. DEAR BOARD CHAIR AND SUPERVISORS, I'M HERE ON BEHALF OF ASSEMBLY MEMBER ROGER HERNANDEZ WHO HAS ASKED THAT I SPEAK ON THE ISSUE OF THE COMMUNITY FIRST CHOICE OPTION ON BEHALF OF S.E.I.U., U.L.T.C.W., THE COMMITTEE FIRST CHOICE OPTION FUNDING PROGRAM WAS CREATED UNDER THE AFFORDABLE CARE ACT TO HELP STATES MOVE AWAY FROM NURSING HOMES AND INSTITUTIONS AND TOWARDS HOME AND COMMUNITY-BASED SERVICES. FUNDING PROVIDES WITH AN ADDITIONAL 6 PERCENT IN FEDERAL MATCHING FUNDING TO ARE THE PROVISION AND ENHANCEMENT OF MEDICAID PERSONNEL, CARE ATTENDANT SERVICES SUCH AS THE I.H.S.S. PROGRAM. THE INTENDED USE OF THIS ADDITIONAL FEDERAL FUNDING PROVIDED IS TO ENHANCE ACCESS TO HOME AND COMMUNITY-BASED SERVICES AND NOT USE THIS FUNDING FOR OTHER PURPOSES. THE SAVINGS FROM THE COMMUNITY FIRST OPTIONS PROGRAM SHOULD BE ALLOCATED TO THE PERSONAL CARE OF ATTENDANT SERVICES LIKE I.H.S.S. THAT THEY WERE INTENDED FOR AND AS THE AFFORDABLE CARE ACT REQUIRES, OR POSSIBLY YOU RISK JEOPARDIZING THIS MUCH NEEDED FEDERAL FUNDING. THEREFORE, ASSEMBLY MEMBER ROGER HERNANDEZ URGES THE BOARD TO CONSIDER HOW THE SAVINGS RESULTING FROM THE COMMUNITY FIRST CHOICE OPTION WILL BE UTILIZED BY THE COUNTY AND TO REFRAIN FROM DIVERTING THOSE SAVINGS TO OTHER PURPOSES. THANK YOU. 

SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. ERIC PREVEN AND ARNOLD SACHS? HAROLD FULLER? 

HAROLD FULLER: YES, SIR. HAROLD FULLER. GREETINGS TO THE SUPERVISORS OF L.A. COUNTY. I'M A DIRECTOR FOR THE GOVERNMENT OF ETHIOPIA. I SPOKE WITH THE GENTLEMAN, THE LADY ON TWO OTHER PRIOR OCCASIONS PERTAINING TO FOSTER CHILDREN TO WHICH I'M BACK ONE MORE TIME TO TRY TO WORK WITH THE SUPERVISORS BECAUSE I SEE TOO MUCH PROBLEMS WITH THE FOSTER KIDS HERE IN THE STATE OF CALIFORNIA. AND I AM COMING TO THE INTERNATIONAL COMMUNITY TO DEAL WITH THE FOSTER CHILDREN TO MAKE A BETTER WAY FOR THEM BECAUSE I SEE THROUGH MY GOVERNMENT THAT THE COUNTY DO NOT FULFILL THEIR OBLIGATIONS TO THE INTERNATIONAL COMMUNITY OF FOSTER CHILDREN AND I'M HERE TO TAKE ON THAT TASK. SO I'D LIKE SOME TIME FOR US TO SIT DOWN AND SPEAK ON THAT SO WE CAN CHANGE THIS CRISES SO IT WON'T GO TOO FAR DOWN THE LINE AND THE INTERNATIONAL COMMUNITY IS STEPPING UP TO FULFILL THEIR OBLIGATIONS. TO THE INTERNATIONAL CODE. 

SUP. YAROSLAVSKY, CHAIRMAN: OKAY, THANK YOU. 

HAROLD FULLER: YES, SIR. 

SUP. YAROSLAVSKY, CHAIRMAN: MR. PREVEN? 

ERIC PREVEN: YES, SIR. THIS IS ERIC PREVEN THE COUNTY RESIDENT FROM DISTRICT 3. AND AN ITEM THAT FLEW THROUGH EARLIER HAD TO DO WITH MAKING SURE THAT THE REVENUE FROM STARBUCKS, BANK OF AMERICA, ETCETERA, ARE MAKING IT INTO THAT GRAND AVENUE PROJECT. AND I KNOW THAT MAYOR ANTONOVICH HAD INQUIRED AS TO WHETHER OR NOT THE RENTS FOR STARBUCKS WERE BENCH MARKED APPROPRIATELY FOR THE NEIGHBORHOOD AND AREA AND I NEVER HEARD FEEDBACK ON THAT SO I'D LIKE TO BRING THAT TO YOUR ATTENTION. I'D ALSO LIKE TO BRING UP THAT THE ITEM NUMBER 43 THAT WE DISCUSSED EARLIER, THE GOLF COURSE, AND I HAVE TO BE CAUTIOUS BECAUSE I AM OCCASIONALLY A LITTLE BIT SARCASTIC AND THEN MY INTENTION GETS LOST IN THE SHUFFLE. I DON'T REALLY SUPPORT THE AMERICAN GOLF CORPORATION TAKING OVER THE GOLF COURSE THAT WE DISCUSSED EARLIER, EL CARISO. IN FACT I WAS LOOKING AT THE AGREEMENT AND THERE'S A DISCREPANCY THAT I'D LIKE TO BRING UP WITH THE COUNTY COUNSEL TO CHRISTINE _________ ATTENTION WHICH IS THAT ON PAGE THREE IT SAYS IN ADDITION TO THE MONTHLY RENTAL FEE WHICH FOR THE FIVE YEARS IS ABOUT 460,000 DOLLARS REVENUE ABOVE 1.6 MILLION ON AN ANNUAL BASIS THE COUNTY WILL BE ENTITLED TO 10 PERCENT OF THOSE GROSS RECEIPTS. ON PAGE 16, IT SAYS THAT 20 PERCENT OF THE TOTAL ANNUAL GROSS RECEIPTS. SO 10 PERCENT VERSUS 20 PERCENT IS A SIGNIFICANT DISCREPANCY OVER 1.6 MILLION. YOU SHOULD KNOW THAT A GOLF COURSE LIKE THIS CAN BRING UP TO FOUR MILLION DOLLARS, MANY OF THEM. I'M NOT SURE THAT THIS ONE WHICH DID COME INTO SOME DISREPAIR UNDER THE PREVIOUS OWNERSHIP AND DOES HAVE A CLUBHOUSE THAT NEEDS TO BE ESSENTIALLY LEVELED AND REDONE, BUT, AGAIN, WE NEED TO MONITOR THIS STUFF VERY CAREFULLY. AND THE IDEA THAT THIS HAPPENED SUDDENLY IN AN EMERGENCY IS NOT REALLY TRUE, GUYS. WE KNEW THAT THIS WAS A PROBLEM. THE OLD GUY WAS RUNNING IT PASSED AWAY A COUPLE YEARS AGO WAS IN PROBATE AND THERE WAS PLENTY OF TIME FOR THIS. SO I'M JUST ANXIOUS WHEN OUR -- I MEAN NOBODY LIKES A WELL-RUN GOLF COURSE MORE THAN I DO. BUT THIS IS A SWEETHEART DEAL, GUYS. WE GOT TO DO BETTER. AND REGARDING THE PROMENADE, I JUST WANT TO CORRECT WHAT I SAID BEFORE BECAUSE GENEVIEVE WAS ABSOLUTELY RIGHT. IT'S NOT APPROPRIATE TO GIVE A GUY-- 

SUP. YAROSLAVSKY, CHAIRMAN: MR. SACHS? 

ARNOLD SACHS: YES, THANK YOU. GOOD AFTERNOON. ARNOLD SACHS. EIGHTY ITEMS ON TODAY'S AGENDA, THREE MINUTES AND NO SWASTIKA. HOW'D YOU DO THAT? YOU GOT THE NEW RULES EXCLUDES ANYBODY WHO PUTS IN MULTIPLE CARDS FROM DISCUSSION ITEMS, UNLIKE THE RULES DISCUSSED -- AND THAT WAS REALLY QUITE NICE OF YOU AT M.T.A. BOARD MEETING TO CLARIFY THE RULES REGARDING THE RED LINE DISCUSSION AND BEVERLY HILLS AND TO REQUEST WHEN SUPERVISOR ANTONOVICH WAS FISHING FOR REASONS NOT TO ALLOCATE THE FUNDING, FOR DOCUMENTATION, OH, BY THE WAY, ALL THESE ITEMS ARE NEWS ARTICLES ON THE ASSESSOR'S OFFICE IN THE LAST MONTH. THE LAUNDRY'S GETTING -- SMELLS WORSE AND YOU'VE ORDERED AN AUDIT TO CLEAN UP THE PAPERWORK TO MAKE SURE THE BOARD OF SUPERVISORS IS EXCLUDED FROM ANY OF THE DOCUMENTATION THAT MAY COME UP. VERY GOOD. BUT, AGAIN, BACK TO METRO AND YOUR DISCUSSION ON THE RED LINE AND THE FACT THAT YOU MENTION THAT YOU DON'T WANT TO BE CONSIDERED CALL BOZOS FOR NOT BUILDING IT LIKE YOU WERE FOR THE GREEN LINE. LET ME CLARIFY SOMETHING FOR YOU. NOT BUILDING THE GREEN LINE BEING CALLED A BOZO WOULD BE AT THE BOTTOM OF THE BUCKET LIST FOR ALL THE THINGS YOU'VE DONE AT METRO. YOU COULD HAVE BEEN CALLED A BOZO FOR AUTHORIZING THE CONSTRUCTION AUTHORITY FOR THE GREEN LINE WHEN IT WASN'T NEEDED OR NOT BUILDING THE DOWNTOWN CONNECTED WHICH WAS THE BLUE LINE WHICH WOULD HAVE CONNECTED LONG BEACH TO PASADENA. BUT BEST OF ALL IS WHEN YOU ASKED SUPERVISOR ANTONOVICH FOR DOCUMENTATION REGARDING HIS ASSERTION THAT SOMEBODY WHO HAD DONE A REPORT CHANGED THEIR MIND. THIS IS DOCUMENTATION. THIS IS FROM THE COUNTY REGISTER'S OFFICE. BUT I GUESS THAT DOESN'T COUNT. 

SUP. YAROSLAVSKY, CHAIRMAN: OKAY. YOUR TIME IS UP. THANK YOU, MR. SACHS. ALL RIGHT. CLOSED SESSION? 

CLERK SACHI HAMAI: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEM NUMBER CS-1 AND CS-2, CONFERENCES WITH LEGAL COUNSEL REGARDING EXISTING LITIGATION, ITEM NUMBER CS-3, CONFERENCE WITH LEGAL COUNSEL REGARDING SIGNIFICANT EXPOSE TO LITIGATION, ITEM NUMBER CS-4, PUBLIC EMPLOYMENT CONSIDERATION OF CANDIDATES FOR THE POSITION OF COUNTY COUNSEL, AND ITEM NUMBER CS-5, CONFERENCE WITH LEGAL COUNSEL REGARDING EXISTING LITIGATION AS INDICATED ON THE POSTED AND SUPPLEMENTAL AGENDAS. PLEASE BE ADVISED DUE TO THE STATEWIDE ELECTION ON TUESDAY, JUNE 5TH, THE NEXT REGULAR MEETING OF THE BOARD OF SUPERVISORS IS SCHEDULED FOR WEDNESDAY, JUNE 6TH, 2012 AT 9:30 A.M. THANK YOU. 
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